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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Digital Industries
Postfach 48 48
90026 NÜRNBERG
GERMANY

Document order number: A5E39788682
Ⓟ 08/2020 Subject to change

Copyright © Siemens AG 2020.
All rights reserved
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Introduction 1
These instructions contain all information required to commission and use the device. Read the 
instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation.
The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers.
This document is delivered as standard in electronic media with the device. The latest version 
can be downloaded at www.siemens.com (http://support.automation.siemens.com/WW/
view/en/60666565/134200).

1.1 Document history
The following table shows major changes in the documentation compared to the previous 
edition. 
The most important changes in the documentation when compared with the respective 
previous edition are given in the following table.

Edition Note
06/2020 Second edition

• Chapter Technical data (Page 107) updated
• Overall revision of chapters and contents

06/2017 First edition

NOTICE
Use in a domestic environment
This Class A Group 1 equipment is intended for use in industrial areas.
In a domestic environment this device may cause radio interference.

SITRANS MASS 2100 & FC300 (FCT010/DSL)
Operating Instructions, 06/2020, A5E39788682-AB 7

http://support.automation.siemens.com/WW/view/en/60666565/134200
http://support.automation.siemens.com/WW/view/en/60666565/134200


1.2 Product compatibility FCT010
Manual 
edition

Remarks Device revision Compatibility of device integration package

06/2020 Manual upda‐
ted

Modbus RS-485 RTU
FW: 4.xx.xx-xx
HW revision: 3

SIMATIC PDM V8.2 Service 
Pack 1 or later

EDD: 2.00.01 or later

06/2017 New Hardware 
extending sen‐
sor sizes

Modbus RS485 RTU
FW: 4.xx.xx-xx
HW revision: 3

SIMATIC PDM V8.2 Service 
Pack 1

EDD: 2.00.xx or later

1.3 Items supplied: Sensors
• MASS 2100 DI 1.0, DI 1.5, DI 2.1
• Safety note
• SensorFlash
• Calibration certificate

Safety N
ote

• MASS 2100 DI 3, DI 6, DI 15
• Safety note
• SensorFlash
• Calibration certificate

Safety N
ote

Introduction
1.3 Items supplied: Sensors
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• FC300 DN 4
• Safety note
• SensorFlash
• Calibration certificate

Safety N
ote

1.4 Items supplied: Transmitter
Compact system

• FCT010
• Packet of cable glands
• Calibration certificate
• SensorFlash

Safety N
ote

Remote system

• FCT010 remote field mount
• Packet of cable glands
• Calibration certificate
 Safety N

ote

Cal. re
p.

Introduction
1.4 Items supplied: Transmitter
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Note
Supplementary information
Supplementary product and production specific certificates are included on the SensorFlash® SD 
card which is delivered in a plastic bag.

Note
Scope of delivery may vary, depending on version and add-ons. Make sure the scope of delivery 
and the information on the nameplate correspond to your order and the delivery note.

1.5 Checking the consignment
1. Check the packaging and the delivered items for visible damages.
2. Report any claims for damages immediately to the shipping company.
3. Retain damaged parts for clarification.
4. Check the scope of delivery by comparing your order to the shipping documents for 

correctness and completeness.  
WARNING

Using a damaged or incomplete device
Risk of explosion in hazardous areas.
• Do not use damaged or incomplete devices.

1.6 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions form one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. These systems, machines and components should only be connected 
to the enterprise network or the Internet if and only to the extent necessary and with appropriate 
security measures (firewalls and/or network segmentation) in place.
You can find more information on protective measures in the area of industrial security by 
visiting:
https://www.siemens.com/industrialsecurity.
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends performing product updates as soon as they are available and 
using only the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.

Introduction
1.6 Security information
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To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under
https://www.siemens.com/industrialsecurity.

1.7 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical data 
(Page 107).
The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or legal relationship. The sales contract contains all obligations on the part of 
Siemens as well as the complete and solely applicable warranty conditions. Any statements 
regarding device versions described in the manual do not create new warranties or modify the 
existing warranty.
The content reflects the technical status at the time of publishing. Siemens reserves the right to 
make technical changes in the course of further development.

Introduction
1.7 Transportation and storage
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Safety notes 2
2.1 Preconditions for use

This device left the factory in good working condition. In order to maintain this status and to 
ensure safe operation of the device, observe these instructions and all the specifications relevant 
to safety.
Observe the information and symbols on the device. Do not remove any information or symbols 
from the device. Always keep the information and symbols in a completely legible state.

Symbol Explanation
Consult operating instructions

     

WARNING
Improper device modifications   
Risk to personnel, system and environment can result from modifications to the device, 
particularly in hazardous areas.
• Only carry out modifications that are described in the instructions for the device. Failure to 

observe this requirement cancels the manufacturer's warranty and the product approvals.

2.2 Laws and directives
Observe the safety rules, provisions and laws applicable in your country during connection, 
assembly and operation. These include, for example:     
• National Electrical Code (NEC - NFPA 70) (USA)
• Canadian Electrical Code (CEC) (Canada)
Further provisions for hazardous area applications are for example:   
• IEC 60079-14 (international)
• EN 60079-14 (EU)

SITRANS MASS 2100 & FC300 (FCT010/DSL)
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2.2.1 FCC Conformity
US Installations only: Federal Communications Commission (FCC) rules

Note
• This equipment has been tested and found to comply with the limits for a Class A digital 

device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment.

• This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the operating instructions, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference to radio communications, in which case the user will be required to 
correct the interference at his own expense.

2.2.2 Conformity with European directives
The CE marking on the device symbolizes the conformity with the following European directives:

Electromagnetic 
compatibility EMC 
2014/30/EU

Directive of the European Parliament and of the Council on the harmoni‐
sation of the laws of the Member States relating to electromagnetic com‐
patibility

Low voltage direc‐
tive LVD 
2014/35/EU

Directive of the European Parliament and of the Council on the harmoni‐
sation of the laws of the Member States relating to the making available 
on the market of electrical equipment designed for use within certain 
voltage limits

Atmosphère explo‐
sible ATEX 
2014/34/EU

Directive of the European Parliament and the Council on the harmonisa‐
tion of the laws of the Member States relating to equipment and protec‐
tive systems intended for use in potentially explosive atmospheres

2011/65/EU RoHS Directive of the European Parliament and the Council on the restriction of 
the use of certain hazardous substances in electrical and electronic equip‐
ment

The applicable directives can be found in the EC conformity declaration of the specific device.

Note
CE declaration
The CE declaration certificate is available on the SensorFlash SD card delivered with the device. 

Safety notes
2.2 Laws and directives
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2.3 Requirements for special applications
Due to the large number of possible applications, each detail of the described device versions for 
each possible scenario during commissioning, operation, maintenance or operation in systems 
cannot be considered in the instructions. If you need additional information not covered by 
these instructions, contact your local Siemens office or company representative. 

Note
Operation under special ambient conditions
We highly recommend that you contact your Siemens representative or our application 
department before you operate the device under special ambient conditions as can be 
encountered in nuclear power plants or when the device is used for research and development 
purposes.

2.4 Use in hazardous areas
Qualified personnel for hazardous area applications
Persons who install, connect, commission, operate, and service the device in a hazardous area 
must have the following specific qualifications:   
• They are authorized, trained or instructed in operating and maintaining devices and systems

according to the safety regulations for electrical circuits, high pressures, aggressive, and
hazardous media.

• They are authorized, trained, or instructed in carrying out work on electrical circuits for
hazardous systems.

• They are trained or instructed in maintenance and use of appropriate safety equipment
according to the pertinent safety regulations.

WARNING
Use in hazardous area
Risk of explosion.
• Only use equipment that is approved for use in the intended hazardous area and labeled

accordingly.
• Do not use devices that have been operated outside the conditions specified for hazardous

areas. If you have used the device outside the conditions for hazardous areas, make all Ex
markings unrecognizable on the nameplate.

Safety notes
2.4 Use in hazardous areas
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WARNING
Loss of safety of device with type of protection "Intrinsic safety Ex i"
If the device or its components have already been operated in non-intrinsically safe circuits or 
the electrical specifications have not been observed, the safety of the device is no longer 
ensured for use in hazardous areas. There is a risk of explosion.
• Connect the device with type of protection "Intrinsic safety" solely to an intrinsically safe 

circuit.
• Observe the specifications for the electrical data on the certificate and/or in Technical data 

(Page 107).

Safety notes
2.4 Use in hazardous areas
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Description 3
3.1 Overview

SITRANS Coriolis flow meter systems consist of a transmitter and a sensor. The following table 
lists the available combinations of transmitters and sensors.

Transmitter Sensor type
FCT010 MASS 2100

FC300

3.2 System integration
The FCT010 transmitter functions as a Modbus RTU slave with standard Modbus commands 
implemented. Setup parameters, process values, diagnostics, and status information are 
mapped as Modbus registers.   
The device can be connected point-to-point or in a multidrop network in non-hazardous or 
hazardous areas. It can be connected to different hosts for example a PLC system or a PC used as 
service tool or configuration tool.  

Note
Multidrop installations in hazardous areas
Multidrop installations in hazardous areas require explosionproof conduit seals for each device 
in division 1 wiring.
For zone classified locations use of Ex-d cable gland can be used if permitted by national 
installation regulation.

The MASS2100 and FC300 7ME4817-... are preconfigured for integration with the SITRANS 
FCT070.

3.3 Modbus RTU technology FCT010
Modbus RTU is an open serial protocol based on master/slave architecture. The protocol 
interconnects field equipment such as sensors, actuators, and controllers and is widely used in 
both process and manufacturing automation. The fieldbus environment is the base level group 
of digital networks in the hierarchy of plant networks.

SITRANS MASS 2100 & FC300 (FCT010/DSL)
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Features
The SITRANS F Modbus RTU communication complies with the Modbus Serial Line Protocol. 
Among other things this implies a master / slave protocol at level 2 of the OSI model. A node (the 
master) issues explicit commands to one of the slave nodes and processes responses. Slave 
nodes will not transmit data without a request from the master node, and do not communicate 
with other slaves.
Modbus is a mono master system, only one master can be connected at a time.

Unicast communication mode
In unicast mode (master/slave mode) the master sends a request to a specific slave device and 
waits a specified time for a response.

Master

response

request

Slave Slave Slave

Figure 3-1 Unicast Mode

Modbus Frame
The Modbus frame is shown below and is valid for both requests and responses.

Table 3-1 Modbus Frame
SLAVE ADDRESS FUNCTION MODE DATA CRC
1 Byte 1 Byte 0 to 252 Bytes 2 Bytes

References
For further information, please refer to the following specification and guidelines available at 
the Modbus Organization  (http://www.modbus.org/) website
1. Serial Line Specification & Implementation guide
2. Application Protocol Specification

3.4 Design
The SITRANS FC flowmeters use the Coriolis principle to measure flow and is available in a 
compact and a remote design.

Description
3.4 Design
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Compact design
SITRANS MASS 2100 (Di 3, 6, 15) is a single mechanical unit where the transmitter is directly 
mounted on the sensor.

Remote design
SITRANS MASS 2100 (DI 1.5, 3, 6, 15) or FC300 (DN4) sensor unit is remotely connected to a 
SITRANS FCT010 transmitter. 

3.4.1 Sensor design
All primary process measurement of mass flow, volume flow, density and medium temperature 
are made in the FCT010. 
The sensor comprises one single continuous bended tube, with no internal welds. The sensor is 
available in an intrinsically safe (IS) design for hazardous area installations.
The sensors are available in AISI 316L stainless steel and Hastelloy C22 or C4. The enclosure is 
made of AISI 316L stainless steel.
The sensor enclosure can be equipped with a pressure guard or flushed with dry inert gas at the 
threaded ports for non-hazardous applications only.
In the remote configuration, the FCT010 is available in an aluminum enclosure with an ingress 
protection grade of IP67/NEMA 4X. For communication and power supply a 4-wire connection 
can be made via M12 plug and socket or cable gland/conduit entry for cable termination.

Description
3.4 Design
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① Earthing terminal 
② Sensor enclosure
③ Plug and threaded port for e.g. pressure guard

Figure 3-2 Overview, remote and compact configuration

3.5 Nameplate layout
Each part of the FC Coriolis flowmeter has three nameplate types showing the following 
information:
• product identification
• product specifications
• certificates and approvals

Note
Identification
Identify your device by comparing your ordering data with the information on the product 
and specification nameplates.

Description
3.5 Nameplate layout
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3.5.1 MASS 2100 Sensor nameplate

① SITRANS FC MASS 2100 Product name
② CE CE mark
③ 2813 Notified Body ID (ATEX example)
④ Ex approvals Classification for hazardous locations
⑤ Consult the operating instructions
⑥ WEEE symbol, see Disposal (Page 93)
⑦ Manufacturer Manufacturer name and location
⑧ Country Manufacturing country
⑨ Material

Conn.
SEP
Cal. factor
Year of Manuf.

Material of pipe
Process connector
Degree of protection
Calibration factor
Manufacturing year

⑩ QR code Product-specific QR code
⑪ T.amb. Range of ambient temperature
⑫ MAWP Maximum allowable working pressure
⑬ Size Size
⑭ Serial No. Device specific serial number
⑮ Order No. Device specific order number

Figure 3-3 MASS 2100 nameplate example

Flowmeter serial number construction
The flowmeter serial number is constructed as follows:
PPYMDDxxxxxx
where
PP = Production factory (Siemens S.A.S. Haguenau: N1)

Description
3.5 Nameplate layout
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Y = Production year (for encryption, see below)
M = Production month (for encryption, see below)
DD = Production date (for encryption, see below)
xxxxxx = Sequential number
Encryption:

Calendar year (Y) Code
1950, 1970, 1990, 2010 A
1951, 1971, 1991, 2011 B
1952, 1972, 1992, 2012 C
1953, 1973, 1993, 2013 D
1954, 1974, 1994, 2014 E
1955, 1975, 1995, 2015 F
1956, 1976, 1996, 2016 H (G)
1957, 1977, 1997, 2017 J
1958, 1978, 1998, 2018 K
1959, 1979, 1999, 2019 L
1960, 1980, 2000, 2020 M
1961, 1981, 2001, 2021 N
1962, 1982, 2002, 2022 P
1963, 1983, 2003, 2023 R
1964, 1984, 2004, 2024 S
1965, 1985, 2005, 2025 T
1966, 1986, 2006, 2026 U
1967, 1987, 2007, 2027 V
1968, 1988, 2008, 2028 W
1969, 1989, 2009, 2029 X
Month (M) Code
January 1
February 2
March 3
April 4
May 5
June 6
July 7
August 8
September 9
October O
November N
December D
Date (DD) Code
Day 1 to 31 01 to 31 (corresponding to the actual date)

Description
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3.5.2 FC300 Sensor nameplate

SIEMENS

① SITRANS FC300 Product name
② CE CE mark
③ 2813 Notified Body ID (ATEX example)
④ Ex approvals Classification for hazardous locations
⑤ Consult the operating instructions
⑥ WEEE symbol, see Disposal (Page 93)
⑦ Manufacturer Manufacturer name and location
⑧ Country Manufacturing country
⑨ Material

Conn.
SEP
Cal. factor
Year of Manuf.

Material of pipe
Process connector
Degree of protection
Calibration factor
Manufacturing year

⑩ QR code Product-specific QR code
⑪ Tamb. Range of ambient temperature
⑫ MAWP Maximum allowable working pressure
⑬ Size Size
⑭ Serial No. Device specific serial number
⑮ Order No. Device specific order number

Figure 3-4 FC300 nameplate example

Description
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3.5.3 FCT010 Transmitter nameplates

FCT010  transmitter: Nameplate with general information

① SITRANS FCT010 Transmitter product name
② Serial no. Transmitter serial number
③ Consult the operating instructions
④ HW/FW System revision numbers; hardware (HW) and firmware (FW)
⑤ WEEE symbol, see Disposal (Page 93)
⑥ Enclosure Degree of protection
⑦ Year of manuf. Manufacturing year

More detailed manufacturing date information is given in the se‐
rial number found on the identification nameplate

⑧ Manufacturer Manufacturer name and location
⑨ Country Manufacturing country
⑩ Conduit / cable entries Type of conduit / cable entries
⑪ Communication Communication
⑫ Power Supply Power supply
⑬ Order No. Order number

FCT010 transmitter: Nameplate with specific information
21

2

① 2813 ATEX Notified Body ID (SIRA Certification)
② Ex approvals Ex approval specifications for the transmitter 

(for details on all approvals refer to Disposal 
(Page 93))

Description
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Note
Approval identifications
Approval certificates and notified body identifications are available for download at 
www.siemens.com (http://www.siemens.com/processinstrumentation/certificates).

3.6 Features FCT010
• The SITRANS FCT010 can be used as Modbus slave in stand-alone or parallel operation on 

Modbus or third party automation systems
• Compact sensor design
• High immunity against process noise
• Fast response to step changes in flow
• High update rate (100 Hz) on all process values
• Measurement of:

– Mass flow
– Volume flow
– Density
– Medium temperature

• Independent low flow cut-off settings for massflow and volumeflow
• Automatic zero-point adjustment (initiated by host system)
• Process noise damping using digital signal processing (DSP).
• One totalizer for summation of massflow. The totalizer is reset on loss of power.
• Empty pipe monitoring
• Simulation of process values:

– Mass flow
– Volume flow
– Density
– Medium temperature

• Troubleshooting and sensor checking
• Use in hazardous areas according to specification
• Intelligent filtering system for aerated flow
• Unit selection of process values and totalizer

Description
3.6 Features FCT010
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3.7 Applications
The main applications of the Coriolis flowmeter can be found in all industries, such as: 
• Chemical & Pharma: detergents, bulk chemicals, acids, alkalis, pharmaceuticals
• Food & Beverage: dairy products, beer, wine, soft drinks, fruit juices and pulps, bottling, CO2 

dosing, CIP/SIP-liquids, mixture recipe control
• Automotive: fuel injection nozzle & pump testing, filling of AC units, engine consumption, 

paint robots
• Oil & Gas: filling of gas bottles, furnace control, test separators, bore-hole plasticizer dosing, 

water-cut metering
• Water & Waste Water: dosing of chemicals for water treatment

3.8 Approvals
Note
For further details see Certificates and approvals (Page 114).

The device is available with approvals for general purpose and for hazardous areas. In all cases, 
check the nameplate on your device, and confirm the approval rating.

Description
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Installing/mounting 4
4.1 Basic safety notes

CAUTION
Hot surfaces resulting from hot process media
Risk of burns resulting from surface temperatures above 65 °C (149 °F). 
• Take appropriate protective measures, for example contact protection.
• Make sure that protective measures do not cause the maximum permissible ambient 

temperature to be exceeded. Refer to the information in Technical data (Page 107).

WARNING
Wetted parts unsuitable for the process media
Risk of injury or damage to device. 
Hot, toxic and corrosive media could be released if the wetted parts are unsuitable for the 
process medium. 
• Ensure that the material of the device parts wetted by the process medium is suitable for the 

medium. Refer to the information in Technical data (Page 107).

Note
Material compatibility
Siemens can provide you with support concerning selection of sensor components wetted by 
process media. However, you are responsible for the selection of components. Siemens accepts 
no liability for faults or failures resulting from incompatible materials.

WARNING
Unsuitable connecting parts
Risk of injury or poisoning. 
In case of improper mounting, hot, toxic, and corrosive process media could be released at the 
connections.
• Ensure that connecting parts (such as flange gaskets and bolts) are suitable for connection 

and process media.
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WARNING
Exceeded maximum permissible operating pressure
Risk of injury or poisoning.
The maximum permissible operating pressure depends on the device version, pressure limit 
and temperature rating. The device can be damaged if the operating pressure is exceeded. Hot, 
toxic and corrosive process media could be released.
Ensure that maximum permissible operating pressure of the device is not exceeded. Refer to 
the information on the nameplate and/or in Technical data (Page 107).

WARNING
Incorrect mounting at Zone 0
Risk of explosion in hazardous areas.
• Ensure sufficient tightness at the process connection.
• Observe the standard IEC/EN 60079-14.

WARNING
Loss of explosion protection
Risk of explosion in hazardous areas if the device is open or not properly closed.
• Close the device as described in Installing/mounting (Page 27).

CAUTION
External stresses and loads
Damage to device by severe external stresses and loads (e.g. thermal expansion or pipe 
tension). Process media can be released.
• Prevent severe external stresses and loads from acting on the device.

4.1.1 Installation location requirements

NOTICE
Strong vibrations
Damage to device.
• In installations with strong vibrations, mount the transmitter in a low vibration 

environment.

Installing/mounting
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NOTICE
Aggressive atmospheres
Damage to device through penetration of aggressive vapors.
• Ensure that the device is suitable for the application.

NOTICE
Direct sunlight
Damage to device.
The device can overheat or materials become brittle due to UV exposure.
• Protect the device from direct sunlight.
• Make sure that the maximum permissible ambient temperature is not exceeded. Refer to 

the information in Technical data (Page 107).

4.1.2 Proper mounting

NOTICE
Incorrect mounting
The device can be damaged, destroyed, or its functionality impaired through improper 
mounting.
• Before installing ensure there is no visible damage to the device.
• Make sure that process connectors are clean, and suitable gaskets and glands are used.
• Mount the device using suitable tools. Refer to the information in Technical data (Page 107).

WARNING
Loss of type of protection
Risk of explosion. Damage to device if the enclosure is open or not properly closed. The type of 
protection specified on the nameplate or in Technical data (Page 107) is no longer guaranteed.
• Make sure that the device is securely closed.

Installing/mounting
4.1 Basic safety notes

SITRANS MASS 2100 & FC300 (FCT010/DSL)
Operating Instructions, 06/2020, A5E39788682-AB 29



4.2 Installation instructions

4.2.1 Transmitter installation

Wall mounting
1. Mount bracket on a wall using four screws.

2. Mount FCT010 on mounting bracket.

Pipe mounting
1. Mount bracket on a horizontal or a vertical pipe using ordinary hose clips or duct straps.

2. Mount FCT010 on mounting bracket.

Installing/mounting
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4.2.2 Sensor installation

4.2.2.1 Determining a location 

CAUTION
Electromagnetic fields
Do not install the flowmeter in the vicinity of strong electromagnetic fields, for example near 
motors, variable frequency drives, transformers etc.   

Upstream / downstream
• No pipe run requirements, that is straight inlet/outlet sections, are necessary.
• Avoid long drop lines downstream from the sensor to prevent process media separation 

causing air / vapor bubbles in the tube (min. back pressure: 0.2 bar).
• Avoid installing the flowmeter immediately upstream of a free discharge in a drop line.

Location in the system 
The optimum location in the system depends on the application: 
• Liquid applications

Gas or vapor bubbles in the fluid may result in erroneous measurements, particularly in the 
density measurement.
– Do not install the flowmeter at the highest point in the system, where bubbles will be 

trapped.
– Install the flowmeter in low pipeline sections, at the bottom of a U-section in the pipeline.

 

Figure 4-1 Liquid applications, wrong location with trapped air/gas
• Gas applications

Vapor condensation or oil traces in the gas may result in erroneous measurements.
– Do not install the flowmeter at the lowest point of the system.
– Install a filter.

 

Figure 4-2 Gas applications, wrong location with trapped oil

Installing/mounting
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4.2.2.2 Orientation of the sensor 

Flow direction 
The calibrated flow direction is indicated by the arrow on the sensor. Flow in this direction will 
be indicated as positive by default. The sensitivity and the accuracy of the sensor do not change 
with reverse flow. 
The indicated flow direction (positive/negative) is configurable.

CAUTION
Accurate measurement
The sensor must always be completely filled with process media in order to measure accurately. 

Orienting the sensor  
The sensor operates in any orientation. The optimal orientation depends on the process fluid 
and the process conditions. Siemens recommends orienting the sensor in one of the following 
ways: 

4.2.2.3 MASS 2100 DI 1.0 - 2.1

Liquid applications

Horizontal installation, correct Horizontal installation, correct

Vertical installation, correct (liquids without solid 
particles only) Vertical installation, wrong

Installing/mounting
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Note
Air / gas bubbles in the liquid
Install the flowmeter horizontally

Note
Solid particles in the liquid
Install the flowmeter horizontally

Gas applications

Horizontal installation 1 Horizontal installation 2

Vertical installation 1
Vertical installation 2

Installing/mounting
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4.2.2.4 MASS 2100 DI 3 - 15

Liquid applications

Horizontal installation, correct
Horizontal installation, wrong

Vertical installation, correct Vertical installation, wrong

Gas applications

Horizontal installation

Vertical installation (not recommended)

Installing/mounting
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4.2.2.5 Installation in a drop line
Installation in a dropline is only possible if a pipeline reduction or orifice with a smaller cross-
section can be installed to prevent the sensor from being partially drained during the 
measurements. 

① Orifice Pipe
② Valve

Figure 4-3 Installation in drop line

WARNING
Unsuitable connecting parts
Risk of injury or poisoning. 
In case of improper mounting, hot, toxic, and corrosive process media could be released at the 
connections.
• Ensure that connecting parts (such as flange gaskets and bolts) are suitable for connection 

and process media.

4.2.2.6 Mounting the sensor 
• Install the sensor in well-supported pipelines in order to support the weight of the flowmeter.
• Center the connecting pipelines axially in order to assure a stress-free installation. The 

flowmeter must not be used to bring the rest of the pipework into line; make sure the 
pipework is correctly aligned before inserting the flow sensor.

• Install two supports or hangers symmetrically and stress-free on the pipeline in close 
proximity to the process connections.

Installing/mounting
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Note
Handling
Lift the flowmeter by the sensor body. Do not lift the flowmeter by the housing.

Avoid vibrations
• Make sure that any valves or pumps upstream of the sensor do not cavitate and do not send 

vibrations into the sensor.
• Decouple vibrating pipeline from the flow sensor using flexible tube or couplings.

Figure 4-4 Avoid vibrations

Figure 4-5 Non-flexible pipes not recommended in vibrating environment 

Figure 4-6 Flexible pipes recommended in vibrating environment 

Avoid cross talk
When operating more than one flowmeter in one or multiple interconnected pipelines there is 
a risk of cross talk.
Prevent cross talk in one of the following ways: 
• Mount sensors on separate frames
• Decouple the pipeline using flexible tubes or couplings

Installing/mounting
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Figure 4-7 High risk of cross talk when using non-flexible pipes

Figure 4-8 Low risk of cross talk when using flexible pipes and separate frames

4.2.2.7 Hydrostatic testing
The flowmeter is pressure-tested before delivery to 1.5 times the rated working pressure of the 
sensor.
• In the case of process connections pressure-rated less than 100 bar, the connection is the 

limiting component. 
• In the case of process connections pressure-rated above 100 bar (stainless steel sensors) or 

above 160 bar (Hastelloy sensors), the sensor is the limiting component.
In all cases the maximum allowed hydrostatic test pressure (MATP) of the flowmeter is 1.5 times 
the marked MAWP (PS) at 20 °C. 
Pressure test of a completed flow system with piping and other components can be done at 
pressures no higher than 1.5 times the marked MAWP (PS) at 20 °C of the lowest rated system 
component. 

4.2.2.8 Mounting a pressure guard
Pressure guard selection
Siemens does not supply the components of the pressure guard solution because the 
arrangement and components are closely related to individual safety and protection practices in 
each place. 
The selection of pressure guard solution is the responsibility of the user, however Siemens 
recommends the following forms of pressure guard:
• A pressure switch screwed directly or piped into one of the purge ports and connected to an 

automatic shut-off valve will disable pressurized supply to the meter.
• A relief valve or bursting disc screwed directly or piped to one of the purge ports to carry any 

spilt fluid to drain after opening.

Installing/mounting
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The pressure switch and relief valve set point should be 2-3 bar gauge. The pressure switch 
should be rated to withstand the full process pressure and temperature for a short time without 
rupture.

CAUTION
Drain flow
Ensure the drain flow is safely contained away from personnel and other plant or equipment.

Mounting of pressure guard

CAUTION
Non-hazardous areas only
The mounting of a pressure guard is only permitted in non-hazardous areas.

CAUTION
Moisture, liquids or particles getting into the sensor enclosure
All sensors are filled with argon to avoid condensation. Ingress of moisture, liquids or particles 
into the sensor may influence the measurement and in worst case inhibit the measuring 
function.
• Avoid moisture, liquids or particles getting into the sensor enclosure

Install a pressure guard as follows:
1. Place the sensor in a dry, clean place and leave it to acclimatize until it reaches ambient 

temperature, preferred 20°C (68°F) with low humidity (at least below 50% RH).
2. Orient the sensor with the purge ports uppermost to minimize loss of the argon gas filling.
3. Carefully disconnect the nipple (see ① in graphic below) and mount the pressure guard. Use 

the enclosed spare part sealing ring for proper sealing.

Make sure that the pressure guard does NOT touch any of the parts inside the sensor. 
Maximum of 20 mm (0.79") insertion can be accommodated.

Installing/mounting
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CAUTION
Lack of proper sealing
Soft metal sealing rings only maintain a hermetic seal within the enclosure with single use.
• Ensure that soft metal sealing rings are not reused.

WARNING
Operation in proximity with pressure guards
Prevent personal injuries by assuring that operation in close proximity with pressure guards 
cannot take place. 

4.3 Disassembly

DANGER
Pressure applications
Danger to personnel, system and environment will result from improper disassembly.
• Never attempt to loosen, remove, or disassemble process connection while vessel contents 

are under pressure.

WARNING
Incorrect disassembly
The following risks may result from incorrect disassembly: 
- Injury through electric shock
- Risk through emerging media when connected to the process
- Risk of explosion in hazardous area
In order to disassemble correctly, observe the following:
• Before starting work, make sure that you have switched off all physical variables such as 

pressure, temperature, electricity etc. or that they have a harmless value.
• If the device contains hazardous media, it must be emptied prior to disassembly. Make sure 

that no environmentally hazardous media are released.
• Secure the remaining connections so that no damage can result if the process is started 

unintentionally.

Installing/mounting
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Connecting 5
5.1 Basic safety notes

WARNING
Unsuitable cables, cable glands and/or plugs
Risk of explosion in hazardous areas.
• Use only cable glands/plugs that comply with the requirements for the relevant type of 

protection.
• Tighten the cable glands in accordance with the torques specified in Technical data 

(Page 107).
• Close unused cable inlets for the electrical connections.
• When replacing cable glands, only use cable glands of the same type.
• After installation, check that the cables are seated firmly.

WARNING
Incorrect conduit system
Risk of explosion in hazardous areas as result of open cable inlet or incorrect conduit system.
• In the case of a conduit system, mount a spark barrier at a defined distance from the device 

input. Observe national regulations and the requirements stated in the relevant approvals.

NOTICE
Condensation in the device
Damage to device through formation of condensation if the temperature difference between 
transportation or storage and the mounting location exceeds 20 °C (36 °F).
• Before taking the device into operation, let the device adapt for several hours in the new 

environment.

NOTICE
Ambient temperature too high
Damage to cable sheath.
• At an ambient temperature ≥ 60 °C (140 °F), use heat-resistant cables suitable for an 

ambient temperature at least 20 °C (36 °F) higher.
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WARNING
Improper power supply
Risk of explosion in hazardous areas as result of incorrect power supply.
• Connect the device in accordance with the specified power supply and signal circuits. The 

relevant specifications can be found in the certificates, in Technical data (Page 107) or on 
the nameplate.

WARNING
Lack of equipotential bonding
Risk of explosion through compensating currents or ignition currents through lack of 
equipotential bonding.
• Ensure that the device is potentially equalized.
Exception: It may be permissible to omit connection of the equipotential bonding for devices 
with type of protection "Intrinsic safety Ex i".

WARNING
Unprotected cable ends
Risk of explosion through unprotected cable ends in hazardous areas.
• Protect unused cable ends in accordance with IEC/EN 60079-14.

WARNING
Improper laying of shielded cables
Risk of explosion through compensating currents between hazardous area and the 
non‑hazardous area.
• Shielded cables that cross into hazardous areas should be grounded only at one end.
• If grounding is required at both ends, use an equipotential bonding conductor.

WARNING
Insufficient isolation of intrinsically safe and non-intrinsically safe circuits
Risk of explosion in hazardous areas.
• When connecting intrinsically safe and non‑intrinsically safe circuits ensure that isolation is 

carried out properly in accordance with local regulations for example IEC 60079-14.
• Ensure that you observe the device approvals applicable in your country.

Connecting
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WARNING
Connecting or disconnecting device in energized state
Risk of explosion in hazardous areas.
• Connect or disconnect devices in hazardous areas only in a de-energized state.
Exceptions:
• Devices having the type of protection "Intrinsic safety Ex i" may also be connected in 

energized state in hazardous areas.

WARNING
Incorrect selection of type of protection
Risk of explosion in areas subject to explosion hazard.
This device is approved for several types of protection. 
1. Decide in favor of one type of protection.
2. Connect the device in accordance with the selected type of protection.
3. In order to avoid incorrect use at a later point, make the types of protection that are not used 

permanently unrecognizable on the nameplate.

Note
Electromagnetic compatibility (EMC)
You can use this device in industrial environments, households and small businesses.
For metal enclosures there is an increased electromagnetic compatibility compared to high-
frequency radiation. This protection can be increased by grounding the enclosure.

See also
Basic safety notes (Page 41)

Note
Improvement of interference immunity
• Lay signal cables separate from cables with voltages > 60 V.
• Use cables with twisted wires.
• Keep device and cables at a distance from strong electromagnetic fields.
• Take account of the conditions for communication specified in the Technical data (Page 107).
• Use shielded cables to guarantee the full specification according to HART/PA/FF/Modbus/

EIA-485/Profibus DP.

Connecting
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5.2 Wiring

Hazardous area applications
Special requirements apply to the location and interconnection of sensor and transmitter. 
See Use in hazardous areas (Page 15).

WARNING
Transmitter enclosure
Before opening the terminal box check that: 
• No explosion hazard exists
• All connection leads are potential free

5.3 Connecting MASS 2100/FC300

WARNING
Improper handling
The sensor connected to this device can be operated with high pressure and corrosive media. 
Therefore improper handling of the device can lead to serious injuries and/or considerable 
material damage.

The device is optionally provided with a preformed cable terminated with M12 style stainless 
steel weather-proof plugs.
The cable shield is physically and electrically terminated within the body of the plug.
Take care when handling the cable and passing it through cable ducting. The plug is not 
subjected to excessive tension (pulling) as the internal connections may be disengaged.

Note
Never pull the cable by the plug.

1. Connect the device using the supplied 4-wire cable with M12 plug.
Note
Grounding
The sensor cable screen is electrically connected to chassis, only when the M12 plug is 
correctly tightened. 

Connecting
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Terminal number Description Wire color (Siemens cable)
1 15 V Orange
2 0 V Yellow
3 RS-485 / B White
4 RS-485 / A Blue

• Only use cables with at least the same degree of protection as the sensor to install the sensor.
It is recommended to use cables supplied by Siemens.

• Siemens supplied cables can be ordered with M12 plug on one or both ends or without plug.
• To guarantee the IP67 degree of protection, ensure that both ends of the cables are given 

equivalent protection from ingress of moisture.
• For further information on Siemens-supplied cables, see Technical data (Page 107).

WARNING
Cable requirements
Cables must be suitable for the temperature (at least 70 °C) and be flammability-rated to at 
least V-2.

A: Prepare the cable by stripping it at both ends.

Figure 5-1 Cable end
B: Connect wires within the sensor terminal compartment 
1. Remove the lock screw and remove the lid. 
2. Undo the flexible strap. 
3. Disconnect the sensor connection (white plug) from the electronic. 
4. Loosen the mounting screw using a TX10 Torx driver and remove the electronic from the 

housing. 
5. Remove the cap and the ferrule from the cable gland and slide onto the cable. 
6. Push the cable through the open gland and anchor the cable shield and the wires with the 

clamp bar. 
7. Remove the terminal block from the electronic. 

Connecting
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8. Connect the wires to the terminals according to the list below. 

Terminal number Description Wire color (Siemens cable)
1 15 V Orange
2 0 V Yellow
3 RS-485 / B White
4 RS-485 / A Blue

Figure 5-2 Sensor terminal compartment

9. Reinstall the electronic including the mounting screw. 
10.Connect the sensor connection and the sensor cable. 
11.Restore the flexible strap around all wires. 

Connecting
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12.Assemble and tighten the cable gland. 
13.Remove the O-ring from lid. 
14.Reinstate the lid and screw in until the mechanical stop. Wind back the lid by one turn. 
15.Mount the O-ring by pulling it over the lid and tighten the lid until you feel friction from the 

O-ring on both sides. Wind the lid by one quarter of a turn to seal on the O-ring. 
16.Reinstate and tighten the lid lock screw. 

WARNING
Unprotected cable ends
Risk of explosion through unprotected cable ends in hazardous areas.
• Protect unused cable ends in accordance with IEC/EN 60079-14.

5.3.1 Setting the EOL termination DIP switches FCT010
It is important to terminate the Modbus RS-485 line correctly at the start and end of the bus 
segment. Impedance mismatch results in reflections on the line which can cause faulty 
communication transmission.
If the device is at the end of the bus segment, it is recommended to terminate the device. The 
following table shows the relation between the DIP switch settings and the permissible 
communication interface set-ups. 

Note
End Of Line (EOL) termination
The FCT010 EOL termination DIP switch is default set to EOL non-active. If the installation 
requires active termination resistors, the DIP switches should be set to the EOL Active state.

CAUTION
Hazardous areas
Only change the DIP switches in hazardous areas when the device is deenergized.

Connecting
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Location of DIP switch
The DIP switch is located in the electronic as shown below.

DIP switch settings for communication set-up
DIP switch Com‐
munication set-
up 

Switch 1 Switch 2 Switch 3 Switch 4

EOL active On On On On
EOL not active On On Off Off

NOTICE
Avoid DIP switch settings not mentioned in the table
DIP switch settings not mentioned in the table preceding are not allowed and may reduce 
communication interface reliability.

Connecting
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Commissioning 6
6.1 Basic safety notes

WARNING
Improper commissioning in hazardous areas
Device failure or risk of explosion in hazardous areas.
• Do not commission the device until it has been mounted completely and connected in 

accordance with the information in Installing/mounting (Page 27).
• Before commissioning take the effect on other devices in the system into account.

WARNING
Commissioning and operation with pending error
If an error message appears, correct operation in the process is no longer guaranteed.
• Check the gravity of the error.
• Correct the error.
• If the error still exists:

– Take the device out of operation.
– Prevent renewed commissioning.

DANGER
Toxic gases and liquids
Danger of poisoning when venting the device: if toxic process media are measured, toxic gases 
and liquids can be released.
• Before venting ensure that there are no toxic gases or liquids in the device, or take the 

appropriate safety measures.

WARNING
Loss of explosion protection
Risk of explosion in hazardous areas if the device is open or not properly closed.
• Close the device as described in Installing/mounting (Page 27).
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WARNING
Opening device in energized state
Risk of explosion in hazardous areas
• Only open the device in a de-energized state.
• Check prior to commissioning that the cover, cover locks, and cable inlets are assembled in 

accordance with the directives.
Exception: Devices having the type of protection "Intrinsic safety Ex i" may also be opened in 
energized state in hazardous areas.

WARNING
Improper handling
The sensor connected to this device can be operated with high pressure and corrosive media. 
Therefore improper handling of the device can lead to serious injuries and/or considerable 
material damage.

6.2 General requirements
Before commissioning it must be checked that:
• The device has been installed and connected in accordance with the guidelines provided 

in Installing/mounting (Page 27) and Connecting (Page 41).
• Device installed in hazardous areas meets the requirements described in Use in hazardous 

areas (Page 15).

6.3 Remote commissioning with PDM FCT010

WARNING
Commissioning and operation with pending error
If an error message appears, correct operation in the process is no longer guaranteed.
• Check the gravity of the error.
• Correct the error.
• If the error still exists:

– Take the device out of operation.
– Prevent renewed commissioning.
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6.3.1 Functions in SIMATIC PDM
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
Parameters are identified by name and organized into function groups. See Modbus addressing 
model (Page 151) for more details.
See Modbus addressing model (Page 151) for parameters that do not appear in the menu 
structure in SIMATIC PDM.

6.3.2 Commissioning steps
In the following it is described how to commission the device with SIMATIC PDM.     
The steps are divided into the following sections:
1. Initial setup (Page 51) 
2. Adding device to the communication network (Page 53)
3. Configuring a new device (Page 56). 
4. Wizard - Quick start with PDM (Page 57) 
5. Wizard - Zero point adjustment (Page 62)

6.3.3 Initial setup
To ensure that SIMATIC PDM connects properly complete the two processes outlined below:
1. Deactivate buffers
2. Update the Electronic Device Description (EDD)

Deactivate buffers for RS-485 COM port
This deactivation is required to align SIMATIC PDM with the Modbus modem for Windows® 
operating systems.

Note
You can find support for Windows operating systems here: support.automation.siemens.com 
(http://support.automation.siemens.com)

1. Click "Start" > "Control Panel" to begin configuration.
2. Click on "Hardware and Sound" > "Device Manager".
3. Open "Ports" folder and double-click the COM Port used by the system to open the 

"Communications Port Properties" window.
4. Select the "Port Settings" tab and click the "Advanced" button.
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5. If the "Use FIFO buffers" check box is deselected, click to select.
6. Set "Receiver Buffer" and "Transmitter Buffer" to Low (1).

7. Click "OK" to close out. Close all screens and then reboot.

Update the Electronic Device Description (EDD)
You can locate the EDD in the SIMATIC PDM Device Library under "Devices" > "Modbus" > 
"Sensors" > "Flow" > "Coriolis" > "Siemens AG" > "SITRANS FC". Check the downloads on our 
website (www.siemens.com/FC410) to make sure you have the latest version of SIMATIC PDM, 
the most recent Service Pack (SP) and the most recent hot fix (HF).
Installing a new EDD:
1. Download the EDD from our website (www.siemens.com/FC410) and save the zip file to your 

computer.
2. Launch the SIMATIC PDM Device Integration Manager.
3. Browse to the zipped EDD file and select it.
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6.3.4 Adding a device to communication network
Before setting the parameters, it is necessary to configure the transmitter project in PDM. 
1. Add the device to SIMATIC Modbus network: 

– Select "File" > "New".
Type in a project name, for example FC commissioning.

– Go to "View" and select "Process Device Network" view.
– Right-click on the typed in Project name and select "Insert New Object" > "Networks".
– Right-click on "Networks" and "Insert New Object" > "Communication Network".
– Click on "Assign Device Type" and select "Modbus Network".
– Click "OK" two times.

Your PC is now added to the Modbus Network. 
– Right-click on "Modbus Network" and select "Insert New Object" > "Object".
– Click on "Assign Device Type" , and select "Devices" > "Modbus" > "Sensors" > "Flow" > 

"Coriolis" > "SIEMENS AG" > "SITRANS FC".
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– Click "OK" two times.

Figure 6-1 Assigning Modbus device to network
2. Set up the communication parameters for SIMATIC Modbus network: 

– Select "Networks" > "My computer", right-click on "COM Port Interface" and select "Object 
Properties".
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– Select the "Communication" tab and configure the communication parameters. The 
transmitters default settings are:
 - Transmission rate: 19200 baud 
 - Parity: even

Figure 6-2 Set the COM Port
– Click "OK".

3. Set up the COM interface:
– Select "Modbus Networks". 
– Right-click on the object name "SITRANS FC" and select "Object Properties".
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– Select the "Communication" tab and configure the Modbus address.

Figure 6-3 Set Modbus address
– Click "OK".

6.3.5 Configuring a new device

Note
Configuring device via SIMATIC PDM
• Clicking "Cancel" button during an upload from device to SIMATIC PDM will result in some 

parameters being updated.

1. Check that you have the most recent EDD, and if necessary update it. See Updating the 
Electronic Device Description (EDD) (Page 70).

2. Launch SIMATIC Manager and create a new project for the device. 
3. Open the menu "Device > Operation > Reset > Restore ordered configuration". Select "Yes" 

button and click "OK" to perform a reset to customer ordered settings.
4. After the reset is complete click on “Upload to PG/PC…” to upload the parameters.
5. Configure the device via the quick start wizard. (See Wizard - Quick Start via PDM (Page 57).)
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6.3.6 Wizard - Quick Start via PDM
The Quick Start wizard provides an easy 5-step procedure that configures the device for a simple 
application.
Please consult the SIMATIC PDM operating instructions or online help for details on using 
SIMATIC PDM.

Access level control
The parameters are protected against changes by access level control. To gain access follow this 
procedure:
1. Go to menu "Device" > "Security". 
2. Select "User" and enter the PIN code. 

The default user PIN code is 2457.

Quick Start

Note
- The "Quick Start" wizard settings are inter-related and changes apply only after you click on 
"Apply and Transfer" at the end of step 5 to save settings offline and transfer them to the device.
- Do not use the "Quick Start" wizard to modify individual parameters.
- Click on "Back" to return and revise settings or "Cancel" to exit the "Quick Start".

Launch SIMATIC PDM, open the menu "Device" > "Wizard - Quick Start...", and follow steps 1 to 
5.
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Step 1 - Identification

Note
The layout of the dialog boxes shown may vary according to the resolution setting for your 
computer monitor. The recommended resolution is 1280 x 960.
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1. Click on "Read Data from Device" to upload Quick Start parameter settings from the device to 
the PC/PG and ensure SIMATIC PDM is synchronized with the device.

2. Click on "Next" to accept the default values.

Step 2 - Sensor orientation
Step 2 shows an overview of the various recommended installation orientations depending on 
the application.
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Step 3 - Sensor connection
The transmitter can be ordered with M12 connection or with terminated cable (for example 
conduit connections).
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Step 4 - Measurement function
Configure the measurement conditions for the selected process variables. Change "Flow 
direction" if necessary.

Step 5 - Summary
Check parameter settings, and click on
• "Back" to return and revise values or
• "Apply" to save settings offline or 
• "Apply and Transfer" to save settings offline and transfer them to the device.

Commissioning
6.3 Remote commissioning with PDM FCT010

SITRANS MASS 2100 & FC300 (FCT010/DSL)
Operating Instructions, 06/2020, A5E39788682-AB 61



The message "Quick Start was successful" will appear. Click on "OK".

See also
Configuring a new device (Page 56)

6.3.7 Wizard - Zero Point Adjustment

Note
Preconditions
Before a zero point adjustment is initiated, the pipe must be flushed, filled and at an absolute 
flowrate of zero preferably also at operating pressure and temperature.
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Performing a zero point adjustment 
1. Flush out the flowmeter until a homogenous flow is established and the tubes are completely 

filled.

Figure 6-4 Best practice zero point adjustment with a by-pass line and two shut-off devices
2. Establish zero flow for example by closing the shut off-valves.
3. Wait 1 to 2 minutes for the system to settle, and then perform zero point adjustment as 

described in the following steps.
4. Select "Device" > "Wizard - Zero Point Adjustment..." from the main menu of SIMATIC PDM to 

perform an automatic zero point adjustment.
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5. It is recommended to use the default settings ("Auto"). If necessary, change the "Zero Point 
Adjustment Settings".

6. Click on "Next".
7. Click on "Perform".
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8. During the process a progress bar is visible.
9. At the end of the zero point adjustment the outcome is displayed as an offset and a standard 

deviation.
Note
If you get an error message after the zero point adjustment, refer to Fault codes and 
corrective actions (Page 96).

The system is now ready for normal operation.

6.3.8 Changing parameter settings using SIMATIC PDM

Note
Clicking on "Cancel" during an upload from device to SIMATIC PDM will result in some parameters 
NOT being updated.

Many parameters are accessed via the online menus in SIMATIC PDM, see Parameters accessed 
via drop-down menus (Page 66) for the others.
1. Launch SIMATIC PDM, connect to the appropriate device and upload data.
2. Adjust parameter values in the parameter value field.
3. Click on "Enter". 

The status fields read "Changed".
4. Open the menu "Device".
5. Click on "Download to device".
6. In menu "File" click "Save" to save settings offline. 

The status fields are cleared.
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6.3.9 Parameters accessed via drop-down menus
Click on menu "Device" or "View" to open the associated drop-down menus.

Drop-down menus

Table 6-1 Menu "Device"
Option Description
Download to device Download all writable parameters to the device.
Upload to PC/PG Upload all parameters from the device to the parameter

table.
Assign address and TAG Assign communication address and TAG name.
Value comparison Compare values between device / project.
Object Properties Show Properties for device and project.
Calibration log Create calibration logs for field devices.
Change Log The change log records which actions have been per‐

formed with SIMATIC PDM on devices.
Wizard - Quick Start Start guide for quick commissioning of the device.
Wizard - Zero Point Adjustment Start guide for zero point adjustment (automatic and man‐

ual).
Totalizer Show or change totalizer settings.
Maintenance Show maintenance parameters.
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Option Description
Simulation Start simulation for testing purposes.
Security Select or change access level.
Restore ordered configuration Set all parameters to customer ordered settings.
Communication Show communication settings.

Table 6-2 Menu "View"
Option Description
Process values (online dialog) Show all process values.
Device Diagnostic (online dialog) Show all diagnostics information (alarms and diagnostics 

parameters).
Toolbar (online dialog) Show or hide the toolbar.
Status Bar Show or hide the status bar.
Update Update the content of the active window.

6.3.10 Process values
1. To compare outputs in real time select "View" > "Process values" to see all process values, 

totalizers and loop current.
2. Verify that the process values show the expected values.

Figure 6-5 Process variables

Trend view
Open the menu "View" > "Process values"  and click on one of the "Trend view" buttons to monitor 
the trend of one or all process values available at each tab.
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Operating FCT010 7
7.1 Remote operation

For information on Modbus addresses, registers  and function codes see appendix Modbus 
communication FCT010 (Page 151).

7.1.1 Overview of device configuration software
There are currently two competing technologies for configuring field devices:
• Electronic Device Description Language (EDDL)-based software
• Field Device Tool / Device Type Manager (FDT/DTM)-based software
From a practical point of view, both EDDL and FDT/DTM solutions do the same thing: provide a 
way of reading and writing configuration parameters to field devices and viewing advanced 
diagnostics.

Note
• SIMATIC PDM (an EDDL-based software) configures a field device using the Electronic Device 

Description (EDD) for that device.
• PACTware and Fieldcare (FDT-based software) use the DTM for that field device.

In addition, there is a new standard called Field Device Integration (FDI) which is a merger of 
these two technologies. Many of the major vendors have stated that their configuration 
software will evolve into being an FDI host. At the time this manual was written, Siemens had 
announced that SIMATIC PDM will become a FDI host system in the near future.

7.1.2 SIMATIC PDM

7.1.2.1 Overview SIMATIC PDM
SIMATIC PDM (Process Device Manager) is a general-purpose, manufacturer-independent tool 
for the configuration, parameter assignment, commissioning, diagnostics and maintenance of 
intelligent field devices and field components. Follow-up installations and additional 
information on SIMATIC PDM are available on the Internet at SIMATIC PDM (www.siemens.com/
simatic-pdm).
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
For information on, for example, how to install and integrate devices, commission the software, 
see Operating Manual 'Help for SIMATIC PDM'. The manual is delivered with SIMATIC PDM 
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software. Once the SIMATIC PDM is installed on your computer you find the manual under: Start 
> All programs > Siemens Automation > SIMATIC > Documentation. Link at our website: 'Help for 
SIMATIC PDM' (https://support.industry.siemens.com/cs/ww/de/view/109482406/en).

Note
Field device parameters
• For a list of parameters and additional information, consult section "Parameter assignment 

FCT010 (Page 73)".
• The field device remains in measurement mode during the time you configure the field 

device.

7.1.2.2 Check SIMATIC PDM version

Procedure
1. Go to SIMATIC PDM Download (http://www.siemens.com/simaticpdm/downloads).
2. Check the support page to make sure you have:

– The latest version of SIMATIC PDM
– The most recent Service Pack (SP)
– The most recent hot fix (HF)

7.1.2.3 Updating the Electronic Device Description (EDD)

Procedure
1. Check that the EDD revision match the Firmware revision in the device according to the table 

in section Product compatibility FCT010 (Page 8).
2. Go to the support page Software downloads (http://www.siemens.com/

processinstrumentation/downloads).
3. Enter the product name in the field "Enter search term...".
4. Download the most current EDD of your device.
5. Save files to your computer in an easily accessed location.
6. Launch SIMATIC PDM – Device Integration Manager.

From the File menu, click "Read device descriptions from compressed source...".
7. Browse to the zipped EDD file, select and open it. 
8. Use the "Integration" function to integrate the EDD into the device catalog. The EDD is now 

accessible via SIMATIC Manager.
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7.1.2.4 Set address
Open in SIMATIC PDM the menu Device – Set Address, enter a value for New Address, and click 
on Assign Address.
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Parameter assignment FCT010 8
8.1 Functions

8.1.1 Process values
According to standard practice with serial communication the Modbus RTU signal updates 
primary process values and error status values every 10 ms (100 Hz update rate) synchronous 
with the DSP update cycle.

Process value parameters
Default units for process values can be changed, default values are:
• Mass flow (MassflowValue) [kg/s]
• Volume flow (VolumeflowValue) [m3/s]
• Density (Density) [kg/m3]
• Medium temperature (MediumTemp) [°C]
• Sensor frame temperature [°C]
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Process value Modbus register Units
Mass flow 7400 • g/s (grams per second)

• g/min (grams per minute)
• g/h (grams per hour)
• kg/s (kilograms per second) (default)
• kg/min (kilograms per minute)
• kg/h (kilograms per hour)
• kg/d (kilograms per day)
• t/min (metric tons per minute)
• t/h (metric tons per hour)
• t/d (metric tons per day)
• ton/min (short tons per minute)
• ton/h (short tons per hour)
• ton/d (short tons per day)
• ton (UK)/h (long tons per hour)
• ton (UK)/d (long tons per day)
• lb/s (pounds per second)
• lb/min (pounds per minute)
• lb/h (pounds per hour)
• lb/d (pounds per day)
• Custom
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Process value Modbus register Units
Volume flow 7500 • l/s (liters per second)

• l/min (liters per minute)
• l/h (liters per hour)
• m³/s (cubic meters per second) (default)
• m³/min (cubic meters per minute)
• m³/h (cubic meters per hour)
• m³/d (cubic meters per day)
• Ml/d (megaliters per day)
• gal/s (US gallons per second)
• gal/min (US gallons per minute)
• gal/h (US gallons per hour)
• gal/d (US gallons per day)
• bbl-beer/s (beer barrels per second = 31 US gallons)
• bbl-beer/min (beer barrels per minute = 31 US gallons)
• bbl-beer/h (beer barrels per hour = 31 US gallons)·
• bbl-beer/d (beer barrels per day = 31 US gallons)
• bbl/s (oil barrels per second)
• bbl/min (oil barrels per minute)
• bbl/h (oil barrels per hour)
• bbl/d (oil barrels per day)
• ft³/s (cubic feet per second)
• ft³/min (cubic feet per minute)
• ft³/h (cubic feet per hour)
• ft³/d (cubic feet per day)
• gal/s (UK gallons per second)
• gal/min (UK gallons per minute)
• gal/h (UK gallons per hour)
• gal/d (UK gallons per day)
• Mgal/d (US megagallons per day)
• Custom
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Process value Modbus register Units
Density 7600 • µg/l (micrograms per liter)

• µg/m³ (micrograms per cubic meter)
• mg/l (milligrams per liter)
• g/ml (grams per milliliter)
• g/cm³ (grams per cubic centimeter)
• g/l (grams per liter)
• kg/l (kilograms per liter)
• kg/m³ (kilograms per cubic meter) (default)
• lb/in³ (pounds per cubic inch)
• lb/gal (pounds per US gallon)
• lb/ft³ (pounds per cubic foot)
• ton/yd³ (short tons per cubic yard)
• Custom

Temperature 7700 • °C (degrees Celsius) (default)
• °F (degrees Fahrenheit)
• °R (degrees Rankine)
• K (kelvins)

Mass totalizer  • g (grams)
• kg (kilograms)
• t (metric tons)
• ton (short tons)
• ton (UK) (long tons)
• oz (ounces avoirdupois)
• lb (pounds)
• Custom

8.1.2 Zero point adjustment
See also the description of the Zero point adjustment via SIMATIC PDM (Page 62).

Note
Preconditions
Before a zero point adjustment is initiated, the pipe must be flushed, filled and at an absolute 
flowrate of zero preferably also at operating pressure and temperature.

Note
Change of parameters during zero point adjustment
Do not change any other parameter during the zero point adjustment procedure.

Parameter assignment FCT010
8.1 Functions

SITRANS MASS 2100 & FC300 (FCT010/DSL)
76 Operating Instructions, 06/2020, A5E39788682-AB



Automatic zero point adjustment 
The device measures and calculates the correct zero point automatically.
The automatic zero point adjustment of the flowmeter is set by the following parameters:
• Duration (Modbus address 2135)
• Start Zero Point Adjustment (Modbus address 2180)
When zero adjust is initiated by selecting Start Zero Point Adjustment, the mass flow values are 
acquired and totalized for the configured period (Duration). The default zero point adjustment 
period (30 s.) is normally sufficient for a stable zero point measurement. 

Note
Extremely low flow quantity
If the flow quantity is extremely small, extremely precise measurement is necessary. In this case, 
a long zero point adjustment period can be selected for improved zero point adjustment.

Zero point calculation
During zero point adjustment, an average value is automatically calculated using the following 
formula:

Zero point offset value
Average of N flow values

N

x

x

N

i

i∑
=≡ 1

xi is an instantaneous flow value sampled in 
the time domain
N = Number of samples during zero point ad‐
justment

The offset value must be within the determined Zero Point Offset Limit (Modbus address 2140).

Note
Exceeded zero point offset limit
If the offset value is greater than the configured limit, proceed as follows:
• Check that the tube is completely filled and that the flowrate is absolute zero.
• Check the validity of the configured zero point offset limit.
• Repeat the zero point adjustment.
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Zero point standard deviation
After completion of the procedure, the standard deviation is calculated in accordance with the 
following formula:

Zero point standard deviation
Standard deviation of N values
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The standard deviation contains important feedback on the homogeneity of the fluid, for 
example on the presence of bubbles or particles.
The standard deviation must be within the determined Standard deviation limit (Modbus 
address 2138). 

Note
Exceeded standard deviation limit
If the standard deviation is greater than the configured limit, proceed as follows:
• Check that the tube is completely filled and that the flow rate is absolute zero.
• Check that the installation is vibration-free.
• Check the validity of the configure Standard deviation limit (Modbus address 2138). 
• Repeat the zero point adjustment.

Successful automatic zero point adjustment
If the new zero point offset value is valid, it is automatically stored as the new zero point for the 
sensor. It remains stored in the case of a power failure.

Manual zero point adjustment 
In case an automatic zero point adjustment cannot be performed, it is possible to do a manual 
zero point adjustment by entering the zero point offset value.
1. Select Modbus address 2132 Zero Point Adjustment and set the value to 1 = Manual Zero 

Point Adjustment.
2. Select Modbus address 2133 Manual Zero Point Offset and enter the desired offset value. 

8.1.3 Low flow cut-off
In certain applications, for example dosing applications, no flow signals under a certain flow 
level are desired. In these applications, the flow signal can be forced to zero when the flow is 
lower than a predefined flow value (low flow cut-off). 
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The transmitter provides two parameters for setting the low flow cut-off:
• Mass flow cut-off limit (Modbus address 2125) 
• Volume flow cut-off limit (Modbus address 2170)

8.1.4 Empty tube monitoring
The empty tube monitoring function uses the process density for detecting an empty tube. Use 
of this function is recommended for all standard applications.

Note
Gas applications
Deactivate the empty tube monitoring function.

Empty tube monitoring parameters
Two parameters for setting the empty tube monitoring function are available:
• Empty tube detection (Modbus address 2129)
• Empty tube limit (Modbus address 2127)
The empty tube monitoring is activated via the Empty tube detection parameter. When the 
empty tube monitoring function is on, the mass flow / volume flow value is forced to zero if the 
tube is empty.
The tube is defined as empty if the measured density value is lower than the value defined via 
the Empty tube limit parameter.

Note
Process media density
Risk of unintentionally forcing flow values to zero if the difference between the Empty tube limit 
density value and the density of the process media is not sufficient.
• Ensure sufficient difference between the Empty tube limit density value and the process 

media density.
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8.1.5 Process noise damping

Noise damping function
The dynamic sensitivity of the flow measurement signal to rapid changes in process flows can 
be reduced by use of the process noise damping function. The function is typically used in 
environment with:
• Strongly pulsating flow
• Changing pump speeds
• Large pressure variations

Process noise damping settings
Reduce interfering process noise by increasing the setting of the parameter Process noise 
damping (Modbus address 2130).
• Centrifugal pump (1: low)
• Triplex pump (2)
• Duplex pump (3)
• Simplex pump (4)
• Cam pump (5: high)
The default value is Duplex pump. The damping affects all functions and outputs of the sensor.

Centrifugal pump
(1, low)

Triplex pump (2)

 

Duplex pump
(3, default setting)

 

Simplex pump (4)

 

Cam pump (5, 
high)

 

Note
Increased reaction time
The reaction time of the sensor increases when the process noise is damped.
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8.1.6 Totalizer

Totalizer function
The device has one totalizer function that can be used to totalize the mass flow process value. 
Default unit of the totalizer can be changed, see Modbus register 8320.
The totalizer may be paused, resumed or reset:
• Pause (Modbus address 2613): the totalizer holds the last value before the failure occurred
• Resume (Modbus address 2614): the totalizer continues counting the actual measured value
• Reset (Modbus address 2612): the totalizer continues counting based on the last input value 

(for example mass flow) before the failure occurred.

Note
The totalizer is reset on power failure.

8.1.7 Security
All parameters may be viewed but some are protected against changes by access level control. 
The Security menu makes it possible to gain access to PIN code protected parameters and to 
change PIN codes.
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The access levels are:
• Read only

Allows no configuration. The user is only able to read the parameter values. No PIN code is 
required. 

• User
Allows configuration and service of all parameters except calibration parameters. Default PIN 
code is 2457. 

Note
Auto Log Off function
The access level will be set to Read only mode if the device is powered off.

8.1.8 Simulation
Simulation is used for testing purposes, typically for checking that the readings of the control 
system are correct.
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Process value simulation
The following process values can be simulated:
• Mass flow (Modbus address 2764)
• Density (Modbus address 2766)
• Medium temperature (Modbus address 2768)
• Sensor frame temperature (Modbus address 2770)
• Volume flow (Modbus address 2772)
The simulation can be activated through SIMATIC PDM in the menu Device → Simulation → 
Process Variables.

8.1.9 Changing Modbus communication settings
Changing communication parameters, for example Baud Rate, Modbus Parity Framing or Bus 
Address effects the Modbus communication as follows:
• The new settings have effect only after a reset, either by restarting the device or writing the 

value 1 to Modbus address 600 Restart communication. 
• The new settings will not have effect until the Modbus driver has responded to any ongoing 

Modbus request.
NOTICE
Setting addresses in a multidrop network
It is recommended NOT to use the default address in a multi-drop network. When setting 
device addresses, make sure that each device has a unique address. Replication of addresses 
may cause abnormal behavior of the entire serial bus and make the master unable to 
communicate with all slaves on the bus.  

8.1.10 Float transmission
The Float Byte Order function ensures that the master and slave use the same sequence of the 
bytes when transmitting float values. This enables the user to configure the transmitter using 
the configuration tool, SIMATIC PDM, and operate the device with all types of PLCs without 
reprogramming the PLC. The transmission order is configured by setting the parameter Byte 
Order in the submenu Device → Communication.

Note
The command Restart Communication must be executed to activate the new byte order 
setting.
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This table shows the different options for setting the transmission method:

Selection Sequence
1st 2nd 3rd 4th

1 - 0 - 3 - 2 Byte 1
(MMMMMMMM)

Byte 0
(MMMMMMMM)

Byte 3 
(SEEEEEEE)

Byte 2 
(EMMMMMMM)

0 - 1 - 2 - 3 Byte 0
(MMMMMMMM)

Byte 1
(MMMMMMMM)

Byte 2 
(EMMMMMMM)

Byte 3 
(SEEEEEEE)

2 - 3 - 0 - 1 Byte 2
(EMMMMMMM)

Byte 3 
(SEEEEEEE)

Byte 0
(MMMMMMMM)

Byte 1
(MMMMMMMM)

3 - 2 - 1 - 0 * Byte 3
(SEEEEEEE)

Byte 2 
(EMMMMMMM)

Byte 1
(MMMMMMMM)

Byte 0
(MMMMMMMM)

* = Factory setting
S = Sign
E = Exponent
M = Mantissa

NOTICE
Change of float byte order
If the float byte order is changed by use of PDM to anything other than default, all float values 
shown in PDM are wrong.
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Service and maintenance 9
9.1 Basic safety notes

Note
The device is maintenance-free.

The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
An inspection can include, for example, check of:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover
• Reliability of power supply, lightning protection, and grounds

WARNING
Impermissible repair and maintenance of the device
• Repair and maintenance must be carried out by Siemens authorized personnel only.

WARNING
Impermissible repair of explosion protected devices
Risk of explosion in hazardous areas
• Repair must be carried out by Siemens authorized personnel only.

WARNING
Dust layers above 5 mm
Risk of explosion in hazardous areas.
Device may overheat due to dust build up.
• Remove dust layers in excess of 5 mm.
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NOTICE
Penetration of moisture into the device
Damage to device.
• Make sure when carrying out cleaning and maintenance work that no moisture penetrates 

the inside of the device.

WARNING
Leaks in the sample gas path
Risk of poisoning. 
When measuring toxic process media, these can be released or collect in the device if there are 
leaks in the sample gas path.
• Purge the device as described in Commissioning (Page 49).
• Dispose of the toxic process media displaced by purging in an environmentally friendly 

manner.

WARNING
Use of a computer in a hazardous area
If the interface to the computer is used in the hazardous area, there is a risk of explosion.
• Ensure that the atmosphere is explosion-free (hot work permit).

9.2 Recalibration
Siemens offers to recalibrate the sensor.
The following calibration types are offered as standard according to configuration:
• Standard mass flow calibration
• Density calibration
• Customer specified mass flow calibration
• Accredited Siemens ISO/IEC 17025 mass flow calibration

Note
SensorFlash
For sensor recalibration the SensorFlash memory unit must always be returned with the 
sensor. 
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9.3 Cleaning

Cleaning the enclosure
• Clean the outside of the enclosure with the inscriptions using a cloth moistened with water 

or a mild detergent.
• Do not use any aggressive cleansing agents or solvents, e.g. acetone. Plastic parts or the 

painted surface could be damaged. The inscriptions could become unreadable.

9.3.1 Electrostatic charge

WARNING
Electrostatic charge
Risk of explosion in hazardous areas if electrostatic charges develop, for example, when 
cleaning plastic surfaces with a dry cloth.
• Prevent electrostatic charging in hazardous areas.

9.4 Maintenance and repair work 

WARNING
Impermissible repair of explosion protected devices
Risk of explosion in hazardous areas
• Repair must be carried out by Siemens authorized personnel only.

WARNING
Maintenance during continued operation in a hazardous area
There is a risk of explosion when carrying out repairs and maintenance on the device in a 
hazardous area.
• Isolate the device from power.
- or -
• Ensure that the atmosphere is explosion-free (hot work permit).
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WARNING
Impermissible accessories and spare parts
Risk of explosion in areas subject to explosion hazard.
• Only use original accessories or original spare parts.
• Observe all relevant installation and safety instructions described in the instructions for the 

device or enclosed with the accessory or spare part.

WARNING
Humid environment
Risk of electric shock.
• Avoid working on the device when it is energized.
• If working on an energized device is necessary, ensure that the environment is dry.
• Make sure when carrying out cleaning and maintenance work that no moisture penetrates 

the inside of the device.

WARNING
Enclosure open
Risk of explosion in hazardous areas as a result of hot components and/or charged capacitors 
inside the device. 
To open the device in a hazardous area:
1. Isolate the device from power.
2. Visually inspect sensor inlet and outlet.
Exception: Devices exclusively having Intrinsic safety (Ex i) may be opened in an energized 
state in hazardous areas.

WARNING
Hot, toxic or corrosive process media
Risk of injury during maintenance work.
When working on the process connection, hot, toxic or corrosive process media could be 
released.
• As long as the device is under pressure, do not loosen process connections and do not 

remove any parts that are pressurized.
• Before opening or removing the device ensure that process media cannot be released.
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WARNING
Improper connection after maintenance
Risk of explosion in areas subject to explosion hazard.
• Connect the device correctly after maintenance.
• Close the device after maintenance work.
Refer to Power (Page 107).

The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
An inspection can include check of:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover screws
• Reliability of power supply, lightning protection, and grounds

NOTICE
Repair and service must be carried out by Siemens authorized personnel only.

Note
Siemens defines flow sensors as non-repairable products. 

9.4.1 Maintenance information FCT010

Maintenance information parameters
The basic maintenance information parameters are:
• Current date and time
• Operating time total
• Operating time
• Transmitter Hardware version
• Sensor Hardware version

9.4.2 Service information FCT010
Service information is information about the condition of the device used for diagnostics and 
service purposes.   
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Service information parameters
The basic service information parameters are:
• Driver Current
• Pickup 1 Amplitude
• Pickup 2 Amplitude
• Sensor Frequency
• Process Media Temperature
• Zero Point Adjustment Auto/Manual
• Zero Point Offset Value
• Manual Zero Point
• Zero Point Standard Deviation

9.5 Replacing the device

CAUTION
Corrosive substances
Risk of chemical burns when replacing the sensor.
The sensor in the device contains corrosive substances that result in burns on unprotected skin.
• Make sure that the sensor enclosure is not damaged when replacing the sensor.
• If contact with the corrosive substances occurs, rinse the affected skin immediately with 

large amount of water to dilute substance.

9.6 Spare parts/Accessories

9.6.1 Ordering of spare parts
Ensure that your ordering data is not outdated. The latest ordering data is always available on 
the Internet: Catalog process instrumentation (http://www.siemens.com/
processinstrumentation/catalogs)
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9.6.2 Ex-approved products

Note
Repair of Ex-approved products
It is the customer's responsibility that repair of Ex-approved products fulfill national 
requirements.

9.6.3 Replaceable components
This table gives an overview of which components can be replaced.

Component Order number Photo Replacable in Ex 
devices

Hot swappable 1)

 
SITRANS FC 
Bag of loose parts for sensor 
Contents: 
Screws, O-rings, cable clamp 
parts

A5E03549324 Yes
Observe hazard‐
ous area access 

protocol

No

SITRANS FCT010 
Blind lid in painted aluminum 
small (∅85 mm)
 

A5E03549295 Yes
Observe hazard‐
ous area access 

protocol

Yes
Observe hazardous 
area access proto‐

col

Sensor housing with cable en‐
tries in metric tread

A5E03549313 No No

Sensor housing with cable en‐
tries in NPT tread

A5E03906080 No No

SITRANS FCS400
M12 option for sensor housing

A5E03906095 No No

Frontend cassette
Spare part frontend cassette 
for FCT010/DSL
From firmware 4.0

A5E41526286 No No
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1) Components may be replaced while power is on in non-hazardous areas only. 

9.7 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical data 
(Page 107).

9.8 Return procedure
Enclose the bill of lading, return document and decontamination certificate in a clear plastic 
pouch and attach it firmly to the outside of the packaging.

Required forms
• Delivery note
• Return goods delivery note (http://www.siemens.com/processinstrumentation/

returngoodsnote)
with the following information:
– Product (item description)
– Number of returned devices/replacement parts
– Reason for returning the item(s)

• Decontamination declaration (http://www.siemens.com/sc/declarationofdecontamination)
With this declaration you warrant "that the device/replacement part has been carefully 
cleaned and is free of residues. The device/replacement part does not pose a hazard for 
humans and the environment."
If the returned device/replacement part has come into contact with poisonous, corrosive, 
flammable or water-contaminating substances, you must thoroughly clean and 
decontaminate the device/replacement part before returning it in order to ensure that all 
hollow areas are free from hazardous substances. Check the item after it has been cleaned.
Any devices/replacement parts returned without a decontamination declaration will be 
cleaned at your expense before further processing.
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9.9 Disposal
Devices described in this manual should be recycled. They may not be dis‐
posed of in the municipal waste disposal services according to the Directive 
2012/19/EC on waste electronic and electrical equipment (WEEE).
Devices can be returned to the supplier within the EC, or to a locally ap‐
proved disposal service for eco-friendly recycling. Observe the specific reg‐
ulations valid in your country.
Further information about devices containing batteries can be found at: 
Information about battery / product return (WEEE) (https://
support.industry.siemens.com/cs/document/109479891/)

Note
Special disposal required
The device includes components that require special disposal.
• Dispose of the device properly and environmentally through a local waste disposal 

contractor.
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Diagnostics and troubleshooting FCT010 10
10.1 Device status symbols

Device status symbols
SIMATIC PDM/PLC
Sym‐
bol

Device status Priority

Maintenance alarm 1

Cause: Output signal invalid due to fault in the field device or in the peripherals.
Action: Maintenance is required immediately.
 

Manual operation 4

Cause: Output signal temporarily invalid (e.g. frozen) due to work being performed on the device.
Action: Disable manual mode via HMI or engineering system.
 

Process value alarm 8

Cause: Deviations from permissible ambient or process conditions detected by the device (through self-
monitoring, or warnings / faults in the device) indicate that the measured value is unreliable or deviations 
from the set value in the actuators is most likely greater than anticipated under normal operating con‐
ditions. Process or ambient conditions will damage the device or result in unreliable output.
Action: Check ambient temperature or process conditions. If possible, install device at different location.
 

 

Process value warning 10

Cause: Deviations from permissible ambient or process conditions detected by the device (through self-
monitoring, or warnings / faults in the device) indicate that the measured value is unreliable or deviations 
from the set value in the actuators is most likely greater than anticipated under normal operating con‐
ditions. Process or ambient conditions can damage the device or result in unreliable output.
Action: Check ambient temperature or process conditions. If possible, install device at different location.
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10.2 Fault codes and corrective actions

10.2.1 Diagnostics

ID Icons Message Cause/Action
36 Sensor supply volt. out of 

range
Contact your local Siemens representative.

37 Sensor supply volt. out of 
range

Contact your local Siemens representative.

38 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

39 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

40 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

41 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

42 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

43 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

44 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

45 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

46 Invalid calibration data Contact your local Siemens representative for recalibration.

47 Invalid compensation data Contact your local Siemens representative.

49 Malfunction in Pickup Am‐
plitude

Contact your local Siemens representative.

50 Malfunction in Pickup Am‐
plitude

Contact your local Siemens representative.

55 Malfunction in sensor driv‐
er

Contact your local Siemens representative.

56 Malfunction in sensor driv‐
er

Contact your local Siemens representative.
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ID Icons Message Cause/Action
57 Malfunction in sensor driv‐

er
Contact your local Siemens representative.

58 Unstable driver oscillation Contact your local Siemens representative.

59 Mass flow out of specifica‐
tion

Reduce the flow. If the problem persists, contact your local 
Siemens representative.

60 Volume flow out of speci‐
fication

Reduce the flow. If the problem persists, contact your local 
Siemens representative.

61 Density out of specifica‐
tion

Contact your local Siemens representative.

62 Fluid temp. below limit Increase the fluid temperature. If the problem persists, con‐
tact your local Siemens representative.

63 Fluid temp. above limit Reduce the fluid temperature. If the problem persists, con‐
tact your local Siemens representative.

64 Frame temp. below limit Increase fluid temperature and check that ambient temper‐
ature is within specified limits. If the problem persists, con‐
tact your local Siemens representative.

65 Frame temp. above limit Reduce fluid temperature and check that ambient temper‐
ature is within specified limits. If the problem persists, con‐
tact your local Siemens representative.

66 Standard Deviation above 
limit

Measurement continues with values from last successful 
zero point adjustment. Improve conditions for automatic 
zero point adjustment and repeat adjustment.

67 Zero Point Offset above 
limit

Measurement continues with values from last successful 
zero point adjustment. Improve conditions for automatic 
zero point adjustment and repeat adjustment.

68 Zero point adjustment 
failed

Measurement continues with values from last successful 
zero point adjustment. Improve conditions for automatic 
zero point adjustment and repeat adjustment.

69 Empty Tube Limit' excee‐
ded

Make sure that the sensor is filled with liquid and that the 
liquid density is within the specified 'Empty Tube Limit'.

70 Too little fluid in tube Make sure that the sensor is filled with liquid.

71 Parameter storage mal‐
function

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

72 Internal error in sensor Contact your local Siemens representative.

73 Internal error in sensor Contact your local Siemens representative.

74 Internal error in sensor Contact your local Siemens representative.

75 Internal error in sensor Contact your local Siemens representative

76 Internal error in sensor Contact your local Siemens representative.
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ID Icons Message Cause/Action
77 Internal error in sensor Contact your local Siemens representative.

78 Unstable measurement 
condition

Check if air is present in the liquid and that the flowmeter is 
operated within its specifications.

79 Auto filtering Check that the flowmeter is operated within its specifica‐
tions. Check other alarms to rule out HW malfunction.

87 Sensor startup Unplug and reconnect the sensor cable. If the diagnostic 
persists after the specified startup time, restart the device. 
If the problem persists, contact Technical Support.

10.2.2 Alarm messages
In the following tables the bits for alarm group 1 and alarm group 2 can be found along with 
possible causes and directions for corrective action.

Alarm group 1 (Modbus address 3012)
Bit Diagnostic Action
4
5

Sensor supply volt. out of range Contact Siemens customer support

6
7
8
9

Temperature measurement fault Contact Siemens customer support

10
11
12
13

Flow values not valid Can be due to problems with measured fluid or hardware malfunction. If the 
failure continues then contact Siemens customer support

14 Invalid calibration data Contact Siemens customer support for recalibration
15 Invalid compensation data Contact Siemens customer support
17
18

Malfunction in Pickup Amplitude Contact Siemens customer support

23
24
25

Malfunction in sensor driver Contact Siemens customer support

26 Unstable driver oscillation Contact Siemens customer support
27 Massflow out of specification Reduce the flow. If the failure continues then contact Siemens customer support
28 Volumeflow out of specification Reduce the flow. If the failure continues then contact Siemens customer support
29 Density out of specification Contact Siemens customer support
30 Fluid temp. below limit Increase the fluid temperature. If the failure continues then contact Siemens 

customer support
31 Fluid temp. above limit Reduce the fluid temperature. If the failure continues then contact Siemens 

customer support
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Alarm group 2 (Modbus adddress 3014)
Bit Diagnostic Action
0 Frame temp. below limit Increase fluid temperature and check that ambient temperature is within speci‐

fied limits. If the failure continues then contact Siemens customer support
1 Frame temp. above limit Reduce fluid temperature and check that ambient temperature is within speci‐

fied limits. If the failure continues then contact Siemens customer support
2 Standard Deviation above limit

(shown for only 2 seconds)

Measurement continues with values from last successful zero point adjust‐
ment. Improve conditions for automatic zero point adjustment and repeat ad‐
justment. 

3 Zero Point Offset above limit

(shown for only 2 seconds)

Measurement continues with values from last successful zero point adjust‐
ment. Improve conditions for automatic zero point adjustment and repeat ad‐
justment. 

4 Zero point adjustment failed

(shown for only 2 seconds)

Measurement continues with values from last successful zero point adjust‐
ment. Improve conditions for automatic zero point adjustment and repeat ad‐
justment. 

5 Empty Tube Limit exceeded Make sure that the sensor is filled with liquid and that the liquid density is within 
the specified Empty Tube Limit

6 The sensor is partially filled Make sure that the sensor is filled with liquid 
7 Parameter storage malfunction Turn off the power, wait 5 seconds and turn on the power again. If the failure 

continues then contact Siemens customer support
8
9
10
11
12
13

Internal error in sensor Contact Siemens customer support

14 Unstable measurement condition Check if air is present in the liquid and that the flowmeter is operated within its 
specifications

15 Auto filtering Check that the flowmeter is operated within its specifications. Check other 
alarms to rule out HW malfunction

23 The sensor is stabilizing Turn off the power, wait 5 seconds and turn on the power again. If the failure 
continues then contact Siemens customer support.

10.3 Operation troubleshooting

10.3.1 Updating the firmware

Note
Firmware update
FW update is to be done only by authorized and trained service personnel.
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1. Contact Technical Support (https://support.industry.siemens.com/cs/my/src?lc=en-WW) to 
receive the latest available firmware bundle.

2. Install the SITRANS FC410 service tool (https://support.industry.siemens.com/cs/ww/en/
view/95197152). Use this tool to download the firmware to the transmitter.

3. Click "Scan network" to connect to your device via the Service tool:

4. Select your device in the "Network scan results" list.
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5. Click on "Configure selected device".

6. Go to the tab "FW update".
7. Click "Load FW file".
8. Select firmware bundle.
9. Click "Start FW update".

10.3.2 Troubleshooting sensor-related problems
Incorrect and unstable measurements, especially at low flows, are typically a result of an 
unstable zero point due to:
• Incorrect installation
• Bubbles in the liquid
• Vibrations or cross talk
• Solid particles settling in the liquid
Follow the 4-step guide to troubleshooting:

Step 1 Preliminary application inspection (Page 102)
Step 2 Zero point adjustment (Page 102)
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Step 3 Measurement error calculation (Page 102)
Step 4 Application improvement (Page 103)
The guide enables you to trace the reason for incorrect measurements and to improve the 
application.

10.3.2.1 Step 1: Inspecting the application
Ensure that:
1. The sensor is installed as described in Installing/mounting (Page 27).
2. The sensor is located in a vibration-free position. Vibrations can disturb the sensor and 

therefore cause measurement error.
Depending on application, you should furthermore ensure the following:
• Liquid application

Ensure that the sensor is filled with liquid and liquid only. 
Air or gas bubbles in the liquid cause instability and can result in measurement errors. 
Flush the pipe systems and the sensor for several minutes at maximum flowrate to remove 
any air bubbles which may be present.
Note
The liquid must be homogeneous in order to measure with high accuracy. If the liquid 
contains solid particles of greater density than the liquid, then these solids can settle, 
especially at low flow rates, which will cause instability in the sensor and lead to 
measurement errors.
For pastes or process fluids with suspended solids always orient the sensor vertically with 
flow in upward direction to maintain solids suspension.

• Gas application
Ensure that the gas pressure/temperature conditions contain sufficient superheat to prevent 
dewing or precipitation. If the gas contains vapor or droplets then these may precipitate, 
causing instability.

10.3.2.2 Step 2: Performing a zero point adjustment
The second step in the troubleshooting procedure is to zero point adjust the device. For further 
information on zero point adjustment, see Commissioning (Page 49).

10.3.2.3 Step 3: Calculating the measurement error
The result of the zero point adjustment will show you if the zero point was set under good and 
stable conditions. 
The lower the obtained value of the parameter Zero Point Standard Deviation, the lower is the 
achievable measuring error. For a well-installed flowmeter, the Zero Point Standard Deviation 
corresponds to the specified zero point stability for the sensor size, see Performance (Page 107).
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The parameter Zero Point Standard Deviation is located in the Maintenance & Diagnostics 
menu in the SIMATIC PDM.
• The error curve is plotted from the formula:

E = ±    (Cal)2 +  
z x 100

qm(      )
2

E = Error [%]
Z = Zero point [kg/h]
qm = Mass flow [kg/h]
Cal. = Calibrated flow accuracy: 0.10

FSO (sensors 

max. flow rate) 

Error in % of actual mass flow rate with 95% confidence 

(probability)

Actual mass 

flow rate

-1.0

-0.5

1.0

0.5
 0.15
-0.15

50%25%5% 75% 100%

Table 10-1 Reference conditions for flow calibrations (ISO 9104 and DIN/EN 29104)
Flow conditions Fully developed flow profile
Temperature, 
medium

20 °C ± 2 °C (68 °F ± 3.6 °F)

Temperature, 
ambient

20 °C ± 2 °C (68 °F ± 3.6 °F)

Liquid pressure 2 ± 1 bar
Density 0.997 g/cm3
Supply voltage Un ± 1 %
Warming-up 
time

30 min.

Cable length 5 m between transmitter and sensor

10.3.2.4 Step 4: Improving the application
In the following it is described how to find the causes of a high Zero point standard deviation and 
how to improve the installation.

Setting Low flow cut-off
In order to see if the zero point becomes more stable when making changes / adjustments, the 
Low Mass flow cut-off (MassFlowCutOff) must be set to 0.0 kg/s. 
When Low flow cut-off has been set, it is possible to see the instability directly from the mass 
flow in the online window ("View → Process variables")
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This information can be used to troubleshoot. For example, tightening the brackets which hold 
the sensor, or turning off the pump to check if vibrations from the pump are disturbing the 
sensor, etc.

Incorrect installation of the sensor
• Has the sensor been correctly installed, that is fastened to the floor / wall or frame with good 

mounting brackets as shown in the instructions?
Especially for low flowrates, that is flowrates less than 10% of the maximum capacity of the 
flowmeter, it is important that the sensor is correctly and stably installed.
If the sensor is not correctly fixed in place, the zero point of the sensor will change, leading to 
measuring errors.
Try to tighten up the sensor brackets to see whether the flow instability is reduced.

Vibrations and cross talk
Vibrations in the pipe system are normally generated by pumps.
Typically, cross talk is generated by two sensors of identical size and positioned in close proximity 
in the same pipe, or installed on the same rail or frame.
Vibrations / cross talk have a greater or lesser effect upon the zero point stability and therefore 
also the measurement accuracy.
1. Check whether there are vibrations.

Turn off the pump and check whether the zero point stability improves, that is if the flowrate 
fluctuation in kg/h is reduced.
If the sensor is disturbed by vibration from the pump or by pressure pulsations, the 
installation should be improved or the pump should be exchanged, for example to another 
type.

2. Check for cross talk.
Turn off the power to the other flowmeter(s) and wait approximately 2 minutes, so the 
vibrating tubes in the sensor have stopped vibrating. Then check if the zero point stability has 
improved, that is that the fluctuation in kg/h has been reduced. If this is the case, the sensors 
disturb one another and the installation should be improved.

Air in the liquid
When air is present in the liquid, the zero point becomes unstable, which leads to a poor 
measurement accuracy.
Checking for air:
• Check the Driver current (View → Device diagnostics → Advanced diagnostic)
• Check if the Driver current varies more than ±1 mA. If this is the case, it is usually due to the 

presence of air or gas bubbles in the liquid.
• Increase the pressure in the sensor, creating a large back pressure upon the sensor by 

reducing the opening of the outlet valve or by increasing the pump pressure. Thereby the size 
of air bubbles inside the sensor will be minimized. If the Driver Current value increases and/
or the stability of the Driver current decreases, it is proof that the liquid contains air or gas 
bubbles.
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Typical causes of air in the liquid
• The entry pipe and sensor have not been properly filled with liquid. 
• The pump cavitates, the rotary speed of the pump is too high in relation to the supply of liquid 

to the pump.
• The flow rate in the pipe is too high, so components sitting in front of the flowmeter can 

cause cavitation.
• If there is a filter installed before the flowmeter, it may be close to blocking, which also can 

cause cavitation.
• Liquid flashes to vapor bubbles while passing through partially open valves or orifices.
• The piping on the pump suction side, pump gaskets or the pump itself is not tight. Air gets 

sucked into the system due to a low pressure on the pump suction side.
• The piping on the pump suction side, pump gaskets or the pump itself is not tight. Air gets 

sucked into the system due to a low pressure on the pump suction side.

Solid particles in the liquid
If the solid particles in a liquid have a density higher than that of the liquid, they can precipitate 
inside the sensor and cause instability which leads to a measurement error.
If solid particles are present in the liquid, they must be homogeneously distributed and have 
similar density as the liquid. Otherwise they can cause relatively large measurement errors.
It is important that the sensor is installed so that solid particles can easily run out of the sensor. 
1. Ensure that the sensor is installed vertically with an upwards flow.
2. Check if solid particles are present in the liquid:

Take a sample of the liquid, fill a glass and see if the solids precipitate.

10.4 Diagnosing with PDM
SIMATIC PDM is a suitable tool for diagnosing the device. 
You can use SIMATIC PDM to read all available parameters to a table for analyzing offline, view 
online/actual process values and online/actual diagnostic information.

Requirements
The following procedure must be completed before diagnosing:
• Installation of PDM and PDM device driver 
• Connection of communications or digital communications interface
Refer to Remote commissioning with PDM FCT010 (Page 50).
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Technical data 11
Note
Device specifications
Siemens makes every attempt to ensure the accuracy of these specifications but reserves the 
right to change them at any time.

11.1 Power
Table 11-1 Power supply
Description Specification
Supply voltage [V] 12 - 27 VDC

Um: 60 VDC
 for Ex d, t 12 - 24 VDC
Reverse polarity protection Yes
Power consumption 1.1 W

Specification in case of Intrinsic safety power supply: Ui: 20 V, Ii: 484 mA, Pi: 2.3 W, Li: 0.6 uH, 
Ci: 1.9 nF.

11.2 Performance
Table 11-2 Reference conditions     
Description Specification
Process media Water
Process media temperature 20 °C (68 °F)
Ambient temperature 25 °C (77 °F)
Process media pressure 2 bar (29 psi)
Process media density 0.997 g/cm3 (62.2 lb/ft3)
Reference device orientation Horizontal installation, tubes down, flow in direc‐

tion of arrow on casing, see Installing/mounting 
(Page 27).
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Table 11-3 Mass flow accuracy
Sensor size DI 1.0 DI 1.5 DI 2.1 DI 3 DN4 HP DN4 C22 DN4 316 DI 6 DI 15
Qmin - minimum 
flowrate
[kg/h] (lb/min)

On
request

0.1
(0.22)

On
request

1
(2.2)

On
request

1
(2.2)

1
(2.2)

5
(11.0)

20
(44.1)

Qnom - nominal 
flowrate
[kg/h] (lb/min)

9,8
(21.6)

19.5
(43)

42
(92.6)

90
(198.4)

35
(77.2)

95
(209.4)

140
(308.6)

500
(1102)

3800
(8378)

Qmax - maximum 
flowrate [kg/h] (lb/
min) 

15
(33)

30
(66)

50
(110)

250
(550)

40
(88)

255
(562)

350
(770)

1000
(2200)

5600
(12350)

Max. zero point sta‐
bility
[kg/h]

On
request

0.001
(0.002)

0.001
(0.002)

0.01
(0.02)

On
request

0.01
(0.02)

0.01
(0.02)

0.05
(0.11)

0.2
(0,4)

Measuring accuracy 
[%]

0.3% 0.1% 0.1% 0.1% 0.3% 0.1% 0.1% 0.1% 0.1%

Repeatability error 
[%]

0.05% 0.05% 0.05% 0.05% 0.05% 0.05% 0.05% 0.05% 0.05%

Table 11-4 Density accuracy (liquids)
Sensor size DI 1.0 DI 1.5 DI 2.1 DI 3 DN4 HP 

(DI 2.0)
DN4 C22
(DI 3.0) 

DN4 316
(DI 3.5)

DI 6 DI 15

Density accuracy, 
standard calibration 
[g/cm³]

n/a 0.005 0.005 0.005 n/a 0.0025 0.007 0.005 0.005

Density accuracy, ex‐
tended calibration 
[g/cm³]

n/a 0.001 0.001 0.0015 n/a 0.0025 0.007 0.0015 0.0005

Density repeatability 
[g/cm³]

n/a 0.0002 0.0002 0.0002 n/a 0.0002 0.0002 0.0002 0.0001

Table 11-5 Media temperature accuracy 
Sensor size DI 1.0 DI 1.5 DI 2.1 DI 3 DN4 HP 

(DI 2.0)
DN4 C22
(DI 3.0) 

DN4 316
(DI 3.5)

DI 6 DI 15

Media temperature 
accuracy [°C]

±0.5 ±0.5 ±0.5 ±0.5 ±0.5 ±0.5 ±0.5 ±0.5 ±0.5

Media temperature 
repeatability [°C]

±0.25 ±0.25 ±0.25 ±0.25 ±0.25 ±0.25 ±0.25 ±0.25 ±0.25

Brix error
[°Brix]

n/a 0.2 0.2 0.3 n/a 0.3 0.3 0.3 0.1
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Table 11-6 Additional error by deviations from reference conditions 
Sensor size DI 1.0 DI 1.5 DI 2.1 DI 3 DN4 HP 

(DI 2.0)
DN4 C22
(DI 3.0) 

DN4 316
(DI 3.5)

DI 6 DI 15

Effect of ambient 
temperature 
 [% / K actual flow‐
rate]

< ±0.003 < ±0.003 < ±0.003 < ±0.003 < ±0.003 < ±0.003 < ±0.003 < ±0.003 < ±0.003

Current: < ±0.005 < ±0.005 < ±0.005 < ±0.005 < ±0.005 < ±0.005 < ±0.005 < ±0.005 < ±0.005
Effect of power sup‐
ply fluctuations
[% of measuring val‐
ue on 1% alteration 
from Un]

None None None <0.005% None None None <0.005% <0.005%

Table 11-7 Process media conditions
Sensor size DI 1.0 DI 1.5 DI 2.1 DI 3 DN4 HP 

(DI 2.0)
DN4 C22
(DI 3.0) 

DN4 316
(DI 3.5)

DI 6 DI 15

Process media tem‐
perature (Ts) (min to 
max)
• Standard [°C (°F)]
 

 
-50 °C to + 125 °C (-58 °F to + 257 
°F)

-50 °C to 
+ 180 °C 
(-58 °F to 
+ 356 °F)

-40 °C to 
+ 115 °C 
(-40 °F to 
+ 239 °F)

-40 °C to + 115 °C 
(-40 °F to + 239 °F)

-50 °C to + 180 °C 
(-58 °F to + 356 °F)

• High-tempera‐
ture version [°C 
(°F)]

n/a -50 °C to 
+ 180 °C 
(-58 °F to 
+ 356 °F)

n/a -40 °C to + 180 °C 
(-40 °F to + 356 °F)

Process media densi‐
ty (min to max) [g/
cm3 (lb/inch3]

n/a 0 ... 2.9 g/cm3 (0 ... 0.105 lb/
inch3)

n/a 0 ... 2.9 g/cm3 (0 ... 0.105 lb/inch3)

Process media gauge 
max pressure 316L 
sensors [bar (psi)]

800 bar 
at 20 °C 
640 bar 
at 180 °C 
(Derat‐
ing is lin‐
ear)

230 bar 
at 20°C
(3336 
PSI at 68 
°F)

100 bar 
at 20 °C 
(68 °F)

230 bar 
at 20°C
(3336 
PSI at 68 
°F)

n/a n/a 130 bar 
(1885 
psi)
at 
20-180 
°C (68 
°F-356 
°F)

265 bar 
at 20°C
(3844 
PSI at 68 
°F)

130 bar 
at 20°C
(1885 
PSI at 68 
°F)

Process media gauge 
max pressure 
Hastelloy C22 sen‐
sors [bar (psi)]

n/a 365 bar 
at 20 °C
(5294 
PSI at 68 
°F)

n/a 350 bar 
at 20°C
(5076 
PSI at 68 
°F)

1000 bar 
at max 
20°C
(14503 
psi)

410 bar 
(5945 
psi)
at 
20-180 
°C (68 
°F-356 
°F)

n/a 410 bar 
at 20°C
(5946 
PSI at 68 
°F

200 bar 
at 20°C
(2900 
PSI at 68 
°F)
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Table 11-8 Ex conditions: Max. temperature vs. temperature classifaction (T amb: -20°C to +50°C)
 DI 1/1.5/2.1/3 DI 6/15
T6 75 49
T5 100 100
T4 135 135
T3 180 180

See also
Pressure - temperature ratings (Page 122)

11.3 Construction
Table 11-9 Designated use     
Description Specification
Measurement of process media • Fluid Group 1 (suitable for dangerous fluids)

• Aggregate state: Paste/light slurry, liquid and gas

Table 11-10 Function and system design   
Description Specification
Measuring principle Coriolis
System architecture • Point-to-point  (1 Modbus RTU master - 1 trans‐

mitter slave)
• Multidrop (1 Modbus RTU master - up to 32 

transmitter slaves per segment. Max 247 slaves)

The MASS2100 and FC300 7ME4817-... is preconfigured for integration with the SITRANS 
FCT070.

Note
NPT glands
When using NPT glands, user must take care when packing threads and installing cables that 
sufficient tightness is obtained to prevent ingress of moisture.
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11.4 Design
Table 11-11 Sensor design
Description Specification
Dimension See  Dimension drawings (Page 127)
Process connectors • EN1092-1 B1, PN40, PN100

• ISO 228-1 G *
• ASME B1.20.1 NPT *
• ASME B16.5, Cl 150, Cl 600
• DIN 11851 **
• ISO 2852 **
• ISO 2853 **

Heated enclosure *** EN1092-1 B1, PN40
ASME B16.5, Cl 150

Electrical connection • M12 connector with 4-wire cable
• Standard cable with M20 connector 
• Standard cable with polymer / brass / stainless 

steel cable glands (metric or NPT)
• Armored cable with stainless steel armored ca‐

ble glands (metric or NPT)
• Conduit entries (metric or NPT)

Material  
 Measuring tubes • AISI 316L / EN 1.4435

• Hastelloy C22 / UNS N06022
 Process connectors • Standard: 

– AISI 316L / EN 1.4435 or EN 1.4404
– Hastelloy C22 / UNS N06022

 Sensor enclosure • EN 1.4301, AISI 316L
 DSL enclosure Aluminium with corrosion-resistant coating
Measuring tube design One single bend tube welded directly to the process 

connections at each end
Self-draining design Yes, when mounted in correct position (sensor type 

specific direction)
DN4 self-draining not possible

*: Pressure ratings depend on sensor material
**: Pressure ratings depend on process connection dimension
***: Maximum media temperature 180°C

Technical data
11.4 Design

SITRANS MASS 2100 & FC300 (FCT010/DSL)
Operating Instructions, 06/2020, A5E39788682-AB 111



11.5 Basic electrical requirement for master system
Table 11-12 Power unit   
Description Specification
Protection class Class I (EN60950)
Galvanic isolation primary/secondary SELV acc. to EN 60950 and EN 50178 or equivalent
Master/Receiver Isolation 500 VAC

11.6 Cables and cable entries
The following information applies to cables and cable glands supplied as accessories to the 
device.

Table 11-13 Signal cable, basic data   
Description Specification
Number of conductors 4
Square area [mm2] 0.326 (AWG 22/7)
Screen Common shield for all 4 conductors
Outside color Gray (RAL 7001)
External diameter [mm] 6.5
Maximum length 150 m (492 ft.)
Installation environment Industrial including chemical processing plants
Insulation material Special polyolefin
Halogen-free Yes
RoHS compliant Yes
Torsional strength • >3 million cycles at ± 180° on 200 mm

• Not adapted for garland mounting (festoon)
Permissible temperature range [°C (°F)] -40 to +80 (-40 to +176)
Min. bending radius allowed Single 5 X ø

Table 11-14 Analog connection
Description Specification
Number of conductors 10 (5x2)
Square area [mm2] 0.35 
Screen [m] Twisted and screened in pairs
Outside color                                    Blue
External diameter [mm] 12
Maximum length 15
Installation environment Industrial including chemical processing plants
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Description Specification
Insulation material PVC
Halogen-free Yes
RoHS compliant Yes
Permissible temperature range [°C (°F)] -20 to +105

Table 11-15 Cable glands and entries
Description Specification
Glands • Material

– Nylon1)

– Brass/Ni plated
– Stainless steel AISI 316/1.4404

• Cable cross section
– ∅ 5 to 10 mm (0.20" to 0.39")

Entry • 1 x M20 or 1 X NPT ½" for communication
1): If operating temperature is below -20 °C (-4 °F), use Brass/Ni plated or stainless steel cable 
glands.

Note
Ex installation
Glands must be Ex-d certified.

11.7 Operating conditions
Table 11-16 Basic conditions 
Description Specification
Ambient temperature (°C[°F])
(Humidity max. 90 %)

Operation:
Transmitter

 
-40 to +60 [-40 to +140]

Ambient temperature (°C[°F]) 
(Humidity max. 90 %)

Storage:
Transmitter

 
 
-40 to +70 [-40 to +158]

Climate class DIN 60721-3-4
Altitude Up to 2000 m (6560 ft)
Relative humidity [%] 95
EMC performance EN/IEC 61326-1 (Industry)

Technical data
11.7 Operating conditions

SITRANS MASS 2100 & FC300 (FCT010/DSL)
Operating Instructions, 06/2020, A5E39788682-AB 113



Table 11-17 Cleaning and sterilizing conditions
Description Specification
Cleaning method • CIP

• SIP

11.8 Process variables FCT010
Description Specification
Primary process variables • Mass flow

• Density
• Medium temperature

Derived process variable • Volume flow

11.9 Approvals note
Note
Device-specific approvals
Always refer to nameplates on the device for device-specific approvals.

11.10 Certificates and approvals
FCT010 (can be installed in Zone 1 for gas and Zone 20/21 for dust)
"Intrinsic safety" type of protection  
 ATEX/IECEx

Sira 17ATEX1215X
II 2(1) G
II 1 (1) D
II 2(1) D)
Ex db ia [ia Ga] IIC T6 Gb
Ex db [ia Ga] IIC T6 Gb
Ex ia [ia] IIIC T85°C Da
Ex tb [ia Da] IIIC T85°C Db
Tamb = -20°C to +60°C

 Pressure equipment • 2014/68/EU Pressure Equipment Directive (PED)
• Canadian Registration Number (CRN)
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FC300 (can be installed in Zone 0)
"Intrinsic safety" type of protection  
 ATEX/IECEx

DEMKO 05 ATEX 138072X
II 1G   Ex ia IIC T6…T3 Ga

 cCSAus (Canada, USA)
 

Canada:
Class I Division 1.
Class I Div. 1 Grp. A, B, C, D.
Ex ia IIC T6…T3 IIC Ga
 
USA:
Class I Division 1.
Class I Div. 1 Grp. A, B, C, DA
AEx ia IIC T6…T3 IIC Ga

 EU Declaration of Conformity A5E31814816A/010
 Pressure equipment • 2014/68/EU Pressure Equipment Directive (PED)

• Canadian Registration Number (CRN)

MASS 2100  - compact version (can be installed in Zone 0, 20)
"Intrinsic safety" type of protection  
 ATEX/IECEx

 
Ex ia IIC T6…T3 Ga
Ex ia IIIC T135°C Da (For dust applications (IIIC) the maxi‐
mum ambient temperature is limited to 100°C according 
to IEC 60079-11 table 4.)

 cULus (Canada, USA)
 

Canada:
Class I+II+III Division 1. Grp. A, B, C, D, E, F, G
Ex ia IIC T6…T3 Ga
Ex ia IIIC T135°C Da
 
USA:
Class I Division 1.
Class I+II+III Division 1. Grp. A, B, C, D, E, F, G.
AEx ia IIC T6…T3 Ga
AEx ia IIIC T135°C Da (For dust applications (IIIC) the max‐
imum ambient temperature is limitedto 100°C according 
to IEC 60079-11 table 4.)

 EU Declaration of Conformity A5E31814816A/010
 Pressure equipment • 2014/68/EU Pressure Equipment Directive (PED)

• Canadian Registration Number (CRN)
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MASS 2100  - remote version (can be installed in Zone 0, 20)
"Intrinsic safety" type of protection  
 ATEX/IECEx

 
Ex ia IIC T6…T3 Ga
Ex ia IIIC T135°C Da (For dust applications (IIIC) the maxi‐
mum ambient temperature is limited to 100°C according 
to IEC 60079-11 table 4.)

 cULus (Canada, USA)
 

Canada:
Class I+II+III Division 1. Grp. A, B, C, D, E, F, G
Ex ia IIC T6…T3 Ga
Ex ia IIIC T135°C Da
 
USA:
Class I Division 1.
Class I+II+III Division 1. Grp. A, B, C, D, E, F, G.
AEx ia IIC T6…T3 Ga
AEx ia IIIC T135°C Da (For dust applications (IIIC) the max‐
imum ambient temperature is limited to 100°C according 
to IEC 60079-11 table 4.)

 EU Declaration of Conformity A5E31814816A/010
 Pressure equipment • 2014/68/EU Pressure Equipment Directive (PED)

• Canadian Registration Number (CRN)

11.11 SensorFlash
Table 11-18 SensorFlash 
Description Specification

Micro SD card
Capacity 4 GB
File system support FAT32 / 8.3
Temperature range
Operation:
Storage:

-40 to +85 °C (-40 to 185 °F)
-40 to +100 °C (-40 to 212 °F)
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11.12 Modbus Communication Specification
Table 11-19 Modbus communication specification   
Description Specification
Device type Slave
Baud rates • 9600 

• 19 200 (Factory setting FCT010)
• 38 400 
• 57 600 
• 76 800 
• 115 200 (Factory setting DSL/FCT070)

Number of stations Max. 31 per segment without repeaters
Device address range 1 to 247
Protocol Modbus RTU
Electrical interface RS-485, 2-wire
Connector type M12 or cable termination
Supported function codes • 3: read holding registers

• 16: write multiple registers
• 8: diagnostics

Broadcast No 1)

Maximum cable length [m] 600 meters (@ 115 200 bits/sec)
Standard Modbus over serial line v 1.0 2)

Certification one
Device Profile None

1): Standard restriction. The standard requires a LED indicator for visual diagnosis. This device 
does not support a LED indicator. This device does not react to any Broadcast commands.
2): According to the Specification & Implementation guide v. 1.0 available at the Modbus 
Organization website

Note
Storage location
All Modbus settings of the device are stored in a non-volatile memory.

11.13 PED
The pressure equipment directive 2014/68/EU applies to the alignment of the statutory orders 
of the European member states for pressure equipment. Such equipment in the sense of the 
directive includes vessels, pipelines and accessories with a maximum allowable pressure of 
more than 0.5 bar above atmospheric. Flowmeters are considered as piping.
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A detailed risk analysis of the flowmeter has been performed in accordance with the PED 
2014/68/EU. All risks are assessed to be "none" provided that the procedures and standards 
referenced in these operating instructions are observed.

Division according to the danger potential
Flowmeters which are categorized as piping are divided into categories according to danger 
potential (medium, pressure, nominal diameter). The flowmeters fall into the categories I to III 
or they are manufactured according to Paragraph 3 - Sound Engineering Practice (SEP).
The following criteria are decisive for assessment of the danger potential and are also shown in 
Diagrams 1 to 4, see Diagrams (Page 117).

Fluid group Group 1 or 2
• Aggregate state Liquid or gaseous
• Type of pressur‐

ized equipment
– Pipeline

 
 
Product of pressure and volume (PS * V [barL])

The maximum allowable temperature for the used liquids or gases is the maximum process 
temperature which can occur, as defined by the user. This must be within the limits defined for 
the equipment.

Division of media (liquid/gaseous) into the fluid groups
Fluids are divided according to Article 13 into the following fluid groups:
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Group 1 fluids
Explosive
R phrases: for example: 2, 3 (1, 4, 5, 6, 9, 16, 18, 19, 
44)

Very toxic
R phrases: for example: 26, 27, 28, 39 (32)

Extremely flammable
R phrases: for example: 12 (17)

Toxic
R phrases: for example: 23, 24, 25 (29, 31)
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Highly flammable
R phrases: for example: 11, 15, 17 (10, 30)

Oxidizing 
R phrases: for example: 7, 8, 9 (14, 15, 19)

Flammable
R phrases: for example11 (10)

 

Group 2 fluids
All fluids not belonging to Group 1.
Also applies to fluids which are for example dangerous to the environment, corrosive, dangerous 
to health, irritant or carcinogenic (if not highly toxic).

Conformity assessment
Flowmeters of categories I to III comply with the safety requirements of the directive. They are 
affixed with the CE mark and an EC declaration of conformity is provided.
The flowmeters are subjected to the conformity assessment procedure - Module H.
Flowmeters according to Article 4 Paragraph 3 are designed and manufactured in accordance 
with sound engineering practice. PED conformity reference is not affixed to the CE mark.
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Diagrams
Gases of fluid group 1
• Pipelines according to Article 4 (a) (i) First dash
• Exception: unstable gases belonging to Categories I and II must be included in Category III.
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Figure 11-1 Diagram 1

Gases of fluid group 2
• Pipelines according to Article 4 (a) (i) Second dash
• Exception: liquids at temperatures > 350 °C belonging to Category II must be included in 

Category III.
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Figure 11-2 Diagram 2
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Liquids of fluid group 1
• Pipelines according to Article 4 (a) (ii) First dash
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Figure 11-3 Diagram 3

Liquids of fluid group 2
• Pipelines according to Article 4 (a) (ii) Second dash
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Figure 11-4 Diagram 4

11.14 Pressure - temperature ratings
Pressure - temperature ratings are determined by process connection material and applicable 
standards. The tables below detail the allowed maximum process pressure for sensor variants 
with stainless steel and Hastelloy measuring tubes.
With two major exceptions, the pressure rating of the flow sensors is independent of the process 
medium temperature. Design rules for flange connections in both the EN1092-1 and ASME 
B16.5 standards dictate pressure derating with increasing temperature. The charts below show 
the effect of process medium temperature on the pressure ratings for the flanges within the 
product program.
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11.14.1 Pressure - temperature ratings (stainless steel sensors) 

Table 11-20 EN1092-1 [bar]
PN (bar) Temperature TS (°C)

-50 0 50 100 150 180
16 16.0 16.0 16.0 15.2 13.8 13.1
40 40.0 40.0 40.0 37.9 34.5 32.9
63 63.0 63.0 63.0 59.7 51.8 51.8
100 100.0 100.0 100.0 94.8 86.2 82.1

Note
Maximum pressure depends on process connection.

Table 11-21 ISO228-G and ASME B1.20.1 NPT [bar]
DN Temperature TS (°C)

-40 to +38
 

180

1,5 230 220
3 230 230
4 130 124
6 226 217
15 130 124

Table 11-22 ASME B16.5 [bar]
Class / Group Temperature TS (°C)

-50 0 50 100 150 200
150 19 19 18.4 16.2 14.8 13.7
600 99.3 99.3 96.2 84.4 77.0 71.3

Table 11-23 DIN 11851 [bar]
PN (bar) Temperature TS (°C)

-50 0 50 100 140
40 40 40 40 40 40
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Table 11-24 DIN 32676 & ISO 2852 [bar]
PN (bar) / DN Temperature TS (°C)

-50 0 50 100 140
25 25 25 25 25 25

Table 11-25 DIN 11864 & ISO 2853 [bar]
PN (bar) / DN Temperature TS (°C)

-50 0 50 100 140
40 40 40 40 40 40

Note
Test pressure
Maximum allowable test pressure (MATP) for the flowmeter and process connection is 1.5 times 
the nominal pressure.

11.14.2 Pressure - temperature ratings (Hastelloy sensors)

Table 11-26 EN1092-1 [bar]
PN (bar) Temperature TS (°C)

-50 0 50 100 150 180
16 16.0 16.0 16.0 16.0 16.0 16.0
40 40.0 40.0 40.0 40.0 40.0 40.0
63 63.0 63.0 63.0 63.0 63.0 63.0
100 100.0 100.0 100.0 100.0 100.0 100.0

Table 11-27 ISO228-G and ASME B1.20.1 NPT [bar]
DN Temperature TS (°C)

-40 to +38
 

180

1,5 350 220
3 410 230
4 410 124
6 407 217
15 200 124
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Table 11-28 ASME B16.5 [bar]
Class Temperature TS (°C)

-50 0 50 100 150 180
150 20.0 20.. 19.5 17.7 15.8 14.6
600 103.4 103.4 103.4 103.0 100.3 98.1

Table 11-29 DIN 11851 [bar]
PN (bar) / DN Temperature TS (°C)

-50 0 50 100 140
40 40 40 40 40 40

Technical data
11.14 Pressure - temperature ratings

SITRANS MASS 2100 & FC300 (FCT010/DSL)
Operating Instructions, 06/2020, A5E39788682-AB 125



Technical data
11.14 Pressure - temperature ratings

SITRANS MASS 2100 & FC300 (FCT010/DSL)
126 Operating Instructions, 06/2020, A5E39788682-AB



Dimension drawings 12
12.1 FC300 dimensions

FC300 DN4 Standard version

Figure 12-1 FC300 DN4 HP only available with 9/16” 18UNF connectors
Enclosure is not rated for pressure containment.
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FC300 DN4 high temperature version

Enclosure is not rated for pressure containment.
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12.2 MASS 2100 dimensions
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Figure 12-2 MASS 2100 DI 1.0 only available with 9/16” 18-UNF connectors
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MASS 2100 DI 1.5 & DI 2.1
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Figure 12-3 MASS 2100 DI 1.5 and DI 2.1, standard version, Dimensions in mm (inch)
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MASS 2100 DI 1.5 High-temperature version
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Figure 12-4 MASS 2100 DI 1.5, High-temperature version, Dimensions in mm (inch)
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Remote versions 

Screwed connector for

Di 3 ISO 228/1 - G ¼

and ANSI/ASME

B1.20.1 - 2013 ¼ NPT

Flange EN 1092-1

ANSI B16.5

Clamp

ISO 2852

Dairy screwed

connection

DIN 11851 (screwed)

Table 12-1 Dimensions and weight, remote versions
Sen‐
sor 
size

Connection L1 L2 L3 H1 B1 D1 D2 D3 D4 D5

DI 
(Inch)

Type (size) Pressure 
rating

mm (inch)

3 (1/8") Pipe 
thread ISO 
228/1 - G¼ 
(¼")

PN 100 400 
(15.75
)

280
(11.02
)

75.5
(2.97)

60
(2.36)

0
(0)

21.3
(0.84)

104
(4.09)

- - -

Pipe 
thread AN‐
SI/ASME B 
1.20.1 - ¼" 
NPT (¼")

PN 100 400 
(15.75
)

280
(11.02
)

75.5
(2.97)

60
(2.36)

0
(0)

21.3
(0.84)

104
(4.09)

- - -
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Sen‐
sor 
size

Connection L1 L2 L3 H1 B1 D1 D2 D3 D4 D5

DI 
(Inch)

Type (size) Pressure 
rating

mm (inch)

6 (¼") Pipe 
thread ISO 
228/1 - G¼ 
(¼")

PN 100           

Pipe 
thread AN‐
SI/ASME B 
1.20.1 - ¼" 
NPT (¼")

PN 100           

Flange EN 
1092-1 
(DN 10)

PN 100 580
(22.83
) 

390
(15.35
)

62.0
(2.44)

40
(1.57)

12
(0.47)

17.0
(0.67)

104
(4.09)

100
(3.94)

70.0
(2.76)

14.0
(0.55)

PN 40 560
(22.05
)

390
(15.35
)

62.0
(2.44)

40
(1.57)

12
(0.47)

17.0
(0.67)

104
(4.09)

90.0
(3.54)

60.0
(2.36)

14.0
(0.55)

Flange AN‐
SI B16.5 
(½")

Class 150 623
(24.57
)

390
(15.35
)

62.0
(2.44)

40
(1.57)

12
(0.47)

17.0
(0.67)

104
(4.09)

88.9
(3.5)

60.5
(2.38)

15.7
(0.62)

Class 600 608
(23.94
)

390
(15.35
)

62.0
(2.44)

40
(1.57)

12
(0.47)

17.0
(0.67)

104
(4.09)

95.3
(3.75)

66.5
(2.62)

15.7
(0.62)

Screwed 
connec‐
tion DIN 
11851 
(DN10)

PN 40 532
(20.94
)

390
(15.35
)

62.0
(2.44)

40
(1.57)

12
(0.47)

17.0
(0.67)

104
(4.09)

 
 

-
 

-
 

Clamp ISO 
2852 (25 
mm)

PN 16 568
(22.44
)

390
(15.35
)

62.0
(2.44)

40
(1.57)

12
(0.47)

17.0
(0.67)

104
(4.09)

- - -
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Sen‐
sor 
size

Connection L1 L2 L3 H1 B1 D1 D2 D3 D4 D5

DI 
(Inch)

Type (size) Pressure 
rating

mm (inch)

15 (½") Pipe 
thread ISO 
228/1 - G¼ 
(¼")

PN 100           

Pipe 
thread AN‐
SI/ASME B 
1.20.1 - ¼" 
NPT (¼")

PN 100           

Flange EN 
1092-1 
(DN15)

PN 100 633
(24.96
)

444
(17.48
)

75.5
(2.97)

44
(1.73)

20
(0.79)

21.3
(0.84)

129
(5.08)

105
(2.95)

75.0
(4.13)

14.0
(0.55)

PN 40 620
(24.41
)

444
(17.48
)

75.5
(2.97)

44
(1.73)

20
(0.79)

21.3
(0.84)

129
(5.08)

95.0
(3.74)

65.0
(2.56)

14.0
(0.55)

Flange AN‐
SI B16.5 
(¾")

Class 150 717
(28.23
)

         

Class 600 740
(29.13
)

         

Flange AN‐
SI B16.5 
(1")

Class 150 757
(29.8)

         

Flange EN 
1092-1 
(DN25)

PN 100 760
(29.92
)

         

PN 40 722
(28.43
)

         

Flange AN‐
SI B16.5 
(½")

Class 150 639
(25.16
)

444
(17.48
)

75.5
(2.97)

44
(1.73)

20
(0.79)

21.3
(0.84)

129
(5.08)

88.9
(3.5)

60.5
(2.38)

15.7
(0.62)

Class 600 659
(25.98
)

444
(17.48
)

75.5
(2.97)

44
(1.73)

20
(0.79)

21.3
(0.84)

129
(5.08)

95.3
(3.75)

66.5
(2.62)

15.7
(0.62)

Screwed 
connec‐
tion DIN 
11851 
(DN15)

PN 40 586
(23.07
)

444
(17.48
)

75.5
(2.97)

44
(1.73)

20
(0.79)

21.3
(0.84)

129
(5.08)

- - -

Clamp ISO 
2852 (25 
mm)

PN 16 622
(24.57
)

444
(17.48
)

75.5
(2.97)

44
(1.73)

20
(0.79)

21.3
(0.84)

129
(5.08)

- - -
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12.3 Transmitter dimensions

Compact version

Table 12-2 MASS2100 with FCT010 transmitter
Sensor size L3 H5 H6 H5 + H6

 mm (inch) mm (inch) mm (inch) mm (inch)
3 (1/8) 75.5 (2.9) 82 (3.23) 237 (9.3) 319 (12.5)
6 (¼) 62 (2.44) 72 (2.83) 247 (9.7) 319 (12.5)
15 (½) 75.5 (2.9) 86.5 (3.4) 257 (10.11) 343.5 (13.5)
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Remote version

Dimensions in mm (inch)
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Product documentation and support A
A.1 Product documentation

Process instrumentation product documentation is available in the following formats: 
• Certificates (http://www.siemens.com/processinstrumentation/certificates)   
• Downloads (firmware, EDDs, software) (http://www.siemens.com/processinstrumentation/

downloads) 
• Catalog and catalog sheets (http://www.siemens.com/processinstrumentation/catalogs) 
• Manuals (http://www.siemens.com/processinstrumentation/documentation) 

You have the option to show, open, save, or configure the manual.
– "Display": Open the manual in HTML5 format
– "Configure": Register and configure the documentation specific to your plant
– "Download": Open or save the manual in PDF format
– "Download as html5, only PC": Open or save the manual in the HTML5 view on your PC

You can also find manuals with the Mobile app at Industry Online Support (https://
support.industry.siemens.com/cs/ww/en/sc/2067). Download the app to your mobile device 
and scan the device QR code.

Product documentation by serial number
Using the PIA Life Cycle Portal, you can access the serial number-specific product information 
including technical specifications, spare parts, calibration data, or factory certificates.

Entering a serial number
1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com).
2. Select the desired language.
3. Enter the serial number of your device. The product documentation relevant for your device 

is displayed and can be downloaded.
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.

Scanning a QR code
1. Scan the QR code on your device with a mobile device.
2. Click "PIA Portal".
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.
Certification documents including calibration report are supplied with each sensor included on 
the SensorFlash. Material, pressure test, and factory conformance certificates are optional at 
ordering.
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Note
EAC declaration
The EAC declaration is available on the SensorFlash SD card delivered with the device. 

A.2 Technical support

Technical support
If this documentation does not completely answer your technical questions, you can enter a 
Support Request (http://www.siemens.com/automation/support-request). 
Additional information on our technical support can be found at Technical Support (http://
www.siemens.com/automation/csi/service).   

Service & support on the Internet 
In addition to our technical support, Siemens offers comprehensive online services at Service & 
Support (http://www.siemens.com/automation/service&support).

Contact 
If you have further questions about the device, contact your local Siemens representative at 
Personal Contact (http://www.automation.siemens.com/partner).
To find the contact for your product, go to "all products and branches" and select "Products & 
Services > Industrial automation > Process instrumentation".
Contact address for business unit: 
Siemens AG
Digital Industries
Process Automation
Östliche Rheinbrückenstr. 50 
76187 Karlsruhe, Germany
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Technical reference B
B.1 Theory of operation

The Coriolis principle of measurement
The flow measurement is based on the Coriolis law of motion. Particles moving in a rotating / 
oscillating system will resist imposed oscillations in a manner consistent with their mass and 
velocity (momentum).
The SITRANS F C sensors are energized by an electromagnetic driver circuit which oscillates the 
pipes at their resonant frequency. Two pickups are placed symmetrically on either side of the 
driver to provide position signals for digital processing.
When the media flows through the sensor, Coriolis force will act on the measuring tubes and 
cause deflection which can be measured as a phase shift between Pickup 1 and Pickup 2. The 
phase shift is proportional to the mass flowrate.

 
 

 

 

 

 

 

à à

The frequency (or period) of the vibration is a direct function of the process media density.
The frequency and amplitude of the driver is regulated to ensure a stable output from the 2 
pickups. The temperature of the sensor tubes is measured to provide accurate compensation for 
changes in the material stiffness. As a result the process media temperature is also accurately 
measured.
The flow proportional phase signal from the pickups, the temperature measurement and the 
driver frequency enable calculation and reporting of mass, density, volume, and temperature.
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Digital signal processing (DSP)
The analog to digital conversion takes place in an ultra low noise sigma delta converter with high 
signal resolution. With fast digital signal processing mass flow and density values are calculated 
using a patented DFT technology (Discrete Fourier Transformation). The combination of this 
patented DFT technology and the fast DSP enables short response time (< 10 ms) to changes in 
the measured values. 
The built-in noise filter is configurable and can be used for improving the performance of the 
flowmeter, in case the installation and application conditions are not ideal. Typical process noise 
such as gas bubbles (two-phase-flow) can be reduced through the filter functions.

B.2 Sensor dimension dependent default settings

B.2.1 Mass flow

MASS 2100 
Sensor size Default value kg/s
Upper alarm limit and Upper warning limit
DI 1 0.010
DI 1.5 0.022
DI 2.1 0.043
DI 3 0.088
DI 6 0.353
DI 15 2.209
Lower alarm limit and Lower warning limit
DI 1 -0.010
DI 1.5 -0.022
DI 2.1 -0.043
DI 3 -0.088
DI 6 -0.353
DI 15 -2.209

Sensor size Default value kg/s Default value kg/h
Low flow cut-off
DI 1 0.0000272 0.0980
DI 1.5 0.0000542 0.195
DI 2.1 0.000117 0.42
DI 3 0.000250 0.90
DI 6 0.00139 5
DI 15 0.0106 38
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FC300
Sensor type Sensor size Default value kg/s
Upper alarm limit and Upper warning limit
DN4 HP 2 0.039
DN4 C22 3 0.088
DN4 316 3.5 0.120
Lower alarm limit and Lower warning limit
DN4 HP 2 -0.039
DN4 C22 3 -0.088
DN4 316 3.5 -0.120

Sensor type Sensor size Default value kg/s Default value kg/h
Low flow cut-off
DN4 HP 2 0,0000972 0.35
DN4 C22 3 0,000264 0.95
DN4 316 3.5 0,000389 1.4

B.2.2 Volume flow

MASS 2100 
Sensor size Default value m3/s
Upper alarm limit and Upper warning limit
DI 1 0.0002
DI 1.5 0.00045
DI 2.1 0.00088
DI 3 0.0018
DI 6 0.0072
DI 15 0.0451
Lower alarm limit and Lower warning limit
DI 1 -0.0002
DI 1.5 -0.00045
DI 2.1 -0.00088
DI 3 -0.0018
DI 6 -0.0072
DI 15 -0.0451

Sensor size Default value m3/s Default value m3/h
Low flow cut-off
DI 1 2.72222E-08 0.000098
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Sensor size Default value m3/s Default value m3/h
DI 1.5 5.41667E-08 0.000195
DI 2.1 1.16667E-07 0.00042
DI 3 0.00000025 0.0009
DI 6 1.38889E-06 0.005
DI 15 1.05556E-05 0.038

FC300
Sensor type Sensor size Default value m3/s
Upper alarm limit and Upper warning limit
DN4 HP 2 0.00080
DN4 C22 3 0.0018
DN4 316 3.5 0.0025
Lower alarm limit and Lower warning limit
DN4 HP 2 -0.00080
DN4 C22 3 -0.0018
DN4 316 3.5 -0.0025

Sensor type Sensor size Default value m3/s Default value m3/h
Low flow cut-off
DN4 HP 2 9.72222E-08 0.00035
DN4 C22 3 2.63889E-07 0.00095
DN4 316 3.5 3.88889E-07 0.0014

B.2.3 Standard volume flow

MASS 2100 
Sensor size Default value m3/s
Upper alarm limit and Upper warning limit
DI 1 0.0002
DI 1.5 0.00045
DI 2.1 0.00088
DI 3 0.0018
DI 6 0.0072
DI 15 0.045
Lower alarm limit and Lower warning limit
DI 1 -0.0002
DI 1.5 -0.00045
DI 2.1 -0.00088
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Sensor size Default value m3/s
DI 3 -0.0018
DI 6 -0.0072
DI 15 -0.045

Sensor size Default value m3/s Default value m3/h
Low flow cut-off
DI 1 2.72222E-08 0.000098
DI 1.5 5.41667E-08 0.000195
DI 2.1 1.16667E-07 0.00042
DI 3 0.00000025 0.0009
DI 6 1.38889E-06 0.005
DI 15 1.05556E-05 0.038

FC300
Sensor type Sensor size Default value m3/s
Upper alarm limit and Upper warning limit
DN4 HP 2 0.00080
DN4 C22 3 0.0018
DN4 316 3.5 0.0025
Lower alarm limit and Lower warning limit
DN4 HP 2 -0.00080
DN4 C22 3 -0.0018
DN4 316 3.5 -0.0025

Sensor type Sensor size Default value m3/s Default value m3/h
Low flow cut-off
DN4 HP 2 9.72222E-08 0.00035
DN4 C22 3 2.63889E-07 0.00095
DN4 316 3.5 3.88889E-07 0.0014

B.2.4 Fraction

MASS 2100 
Sensor size Unit Default value
Upper alarm limit and Upper warning limit
DI 1 Mass flow kg/s n/a

Volume flow m3/s n/a
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Sensor size Unit Default value
DI 1.5 Mass flow kg/s 0.022

Volume flow m3/s 0.00045
DI 2.1 Mass flow kg/s 0.043

Volume flow m3/s 0.00088
DI 3 Mass flow kg/s 0.088

Volume flow m3/s 0.0018
DI 6 Mass flow kg/s 0.353

Volume flow m3/s 0.0072
DI 15 Mass flow kg/s 2.209

Volume flow m3/s 0.0451
Lower alarm limit and Lower warning limit
DI 1 Mass flow kg/s n/a

Volume flow m3/s n/a
DI 1.5 Mass flow kg/s -0.022

Volume flow m3/s -0.00045
DI 2.1 Mass flow kg/s -0.043

Volume flow m3/s -0.00088
DI 3 Mass flow kg/s -0.088

Volume flow m3/s -0.0018
DI 6 Mass flow kg/s -0.353

Volume flow m3/s -0.0072
DI 15 Mass flow kg/s -2.209

Volume flow m3/s -0.0451

FC300
Sensor type Sensor size Unit Default value
Upper alarm limit and Upper warning limit
DN4 HP 2 Mass flow kg/s n/a

Volume flow m3/s n/a
DN4 C22 3 Mass flow kg/s 0.088

Volume flow m3/s 0.0018
DN4 316 3.5 Mass flow kg/s 0.120

Volume flow m3/s 0.0025
Lower alarm limit and Lower warning limit
DN4 HP 2 Mass flow kg/s n/a

Volume flow m3/s n/a
DN4 C22 3 Mass flow kg/s -0.088

Volume flow m3/s -0.0018
DN4 316 3.5 Mass flow kg/s -0.120

Volume flow m3/s -0.0025
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B.2.5 Zero point adjustment

MASS 2100 
Sensor size Default value kg/s
Standard deviation limit
DI 1 0
DI 1.5 0.000002
DI 2.1 0.000002
DI 3 0.00002
DI 6 0.0001
DI 15 0.0004

Sensor size Default value kg/s
Zero offset limit
DI 1 0.0000272
DI 1.5 0.0000542
DI 2.1 0.000117
DI 3 0.000250
DI 6 0.00139
DI 15 0.0106

Sensor size Default value kg/s Default value kg/h
Low flow cut-off
DI 1 0.0000272 0.0980
DI 1.5 0.0000542 0.195
DI 2.1 0.000117 0.42
DI 3 0.000250 0.90
DI 6 0.00139 5
DI 15 0.0106 38

FC300
Sensor type Sensor size Default value kg/s
Standard deviation limit
DN4 HP 2 0
DN4 C22 3 0.000002
DN4 316 3.5 0.000002
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Sensor type Sensor size Default value kg/s
Zero offset limit
DN4 HP 2 0.0000972
DN4 C22 3 0.000264
DN4 316 3.5 0.000389

Sensor type Sensor size Default value kg/s Default value kg/h
Low flow cut-off
DN4 HP 2 0.0000972 0.35
DN4 C22 3 0.000264 0.95
DN4 316 3.5 0.000389 1.4

B.3 Exception handling
There is a defined set of exception codes to be returned by slaves in the event of problems. All 
exceptions are signalled in the response from the slave by adding 80 hex to the function code 
of the request and following this byte by an exception code.   

Table B-1 Exception codes
Exception 
code (dec)

Exception text Description

01 Illegal function The function code received in the query is not an allowable 
action for the slave

02 Illegal data address The data address received in the query is not an allowable 
address for the slave.

03 Illegal data value A value contained in the query data field is not an allowable 
value for the addressed location. This may indicate a fault in 
the structure of the remainder of a complex request, such 
that the implied length is incorrect or the number of registers 
is too high.

04 Slave device failure The request is for some other reason not acceptable. It may 
e.g. indicate that the data value to write is evaluated to be 
beyond limits.

B.4 Float definition
Stuffing of multi-byte numbers into multiple Modbus RTU registers differs among Modbus 
devices. "Big Endian" and "Little Endian" describe the order or sequence in which multi-byte data 
is stored in memory. This device uses (IEEE 741) a "Big-Endian" representation for addresses and 
data items as default. This means that when a numerical quantity larger than a single byte is 
transmitted, the MOST significant byte is sent first.
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Float transmission order can be changed as described in Float transmission (Page 83).

Following example describes the  Big-Endian representing of float IEEE741.

Value (decimal) IEEE FP B MSB LSB Register N Register N + 1
high low high low

100.0 42C80000h 42h C8h 00h 00h
55.32 425D47AEh 42h 5Dh 47h AEh

2.0 40000000h 40h 00h 00h 00h
1.0 3F800000h 3Fh 80h 00h 00h
-1.0 BF800000h bFh 80h 00h 00h

Read absolute massflow (4.03001)

Query: 01,03,0B,B8,00,02,46,0A
Response: 01,03,04,40,C3,52,93,62,C8
Absolute mass‐
flow =

6.10383 kg/s

B.5 CRC calculation
The Cyclical Redundancy Checking (CRC) field is two bytes, containing a 16–bit binary value. The 
CRC value is first generated by the transmitting device, which appends the CRC to the message. 
The receiving device recalculates a CRC during receipt of the message, and compares the 
calculated value to the actual value it received in the CRC field. If the two values are not equal an 
error occurs. 
In the following a short text description of how the CRC is calculated is provided. This description 
is then followed by a C programming example. 

CRC calculation
1. Load a 16–bit register with FFFF hex (all 1’s). Call this the CRC register.
2. Exclusive OR the first 8–bit byte of the message with the low–order byte of the 16–bit CRC 

register, putting the result in the CRC register.
3. Shift the CRC register one bit to the right (toward the LSB), zero–filling the MSB. Extract and 

examine the LSB.
4. (If the LSB was 0): Repeat Step 3 (another shift).  (If the LSB was 1): Exclusive OR the CRC 

register with the polynomial value 0xA001 (1010 0000 0000 0001).
5. Repeat Steps 3 and 4 until 8 shifts have been performed. When this is done, a complete 8–bit 

byte will have been processed.
6. Repeat Steps 2 through 5 for the next 8–bit byte of the message. Continue doing this until all 

bytes have been processed.
7. The final content of the CRC register is the CRC value.
8. When the CRC is placed into the message, its upper and lower bytes must be swapped as 

described below.
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Placing the CRC into the Message
When the 16–bit CRC (two 8–bit bytes) is transmitted in the message, the low-order byte will be 
transmitted first, followed by the high-order byte.
For example, if the CRC value is 1241 hex (0001 0010 0100 0001):

Addr Func Data count Data n Data n+1 Data n+2 Data n+x CRC LO CRC HI
 0x41 0x12

CRC programming example
/* Table of CRC values for high-order byte */
static __flash unsigned char auchCRCHi[] = {
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81,
0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0,
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 
0xC1, 0x81, 0x40, 0x01,
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x01, 0xC0, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 
0x40, 0x00, 0xC1, 0x81,
0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0,
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x01,
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81,
0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0,
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 
0xC1, 0x81, 0x40, 0x01,
0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 
0x01, 0xC0, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81,
0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0,
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x01,
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 
0x01, 0xC0, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81,
0x40
} ;

/* Table of CRC values for low-order byte */
static __flash char auchCRCLo[] = {
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0x00, 0xC0, 0xC1, 0x01, 0xC3, 0x03, 0x02, 0xC2, 0xC6, 0x06, 0x07, 
0xC7, 0x05, 0xC5, 0xC4,
0x04, 0xCC, 0x0C, 0x0D, 0xCD, 0x0F, 0xCF, 0xCE, 0x0E, 0x0A, 0xCA, 
0xCB, 0x0B, 0xC9, 0x09,
0x08, 0xC8, 0xD8, 0x18, 0x19, 0xD9, 0x1B, 0xDB, 0xDA, 0x1A, 0x1E, 
0xDE, 0xDF, 0x1F, 0xDD,
0x1D, 0x1C, 0xDC, 0x14, 0xD4, 0xD5, 0x15, 0xD7, 0x17, 0x16, 0xD6, 
0xD2, 0x12, 0x13, 0xD3,
0x11, 0xD1, 0xD0, 0x10, 0xF0, 0x30, 0x31, 0xF1, 0x33, 0xF3, 0xF2, 
0x32, 0x36, 0xF6, 0xF7,
0x37, 0xF5, 0x35, 0x34, 0xF4, 0x3C, 0xFC, 0xFD, 0x3D, 0xFF, 0x3F, 
0x3E, 0xFE, 0xFA, 0x3A,
0x3B, 0xFB, 0x39, 0xF9, 0xF8, 0x38, 0x28, 0xE8, 0xE9, 0x29, 0xEB, 
0x2B, 0x2A, 0xEA, 0xEE,
0x2E, 0x2F, 0xEF, 0x2D, 0xED, 0xEC, 0x2C, 0xE4, 0x24, 0x25, 0xE5, 
0x27, 0xE7, 0xE6, 0x26,
0x22, 0xE2, 0xE3, 0x23, 0xE1, 0x21, 0x20, 0xE0, 0xA0, 0x60, 0x61, 
0xA1, 0x63, 0xA3, 0xA2,
0x62, 0x66, 0xA6, 0xA7, 0x67, 0xA5, 0x65, 0x64, 0xA4, 0x6C, 0xAC, 
0xAD, 0x6D, 0xAF, 0x6F,
0x6E, 0xAE, 0xAA, 0x6A, 0x6B, 0xAB, 0x69, 0xA9, 0xA8, 0x68, 0x78, 
0xB8, 0xB9, 0x79, 0xBB,
0x7B, 0x7A, 0xBA, 0xBE, 0x7E, 0x7F, 0xBF, 0x7D, 0xBD, 0xBC, 0x7C, 
0xB4, 0x74, 0x75, 0xB5,
0x77, 0xB7, 0xB6, 0x76, 0x72, 0xB2, 0xB3, 0x73, 0xB1, 0x71, 0x70, 
0xB0, 0x50, 0x90, 0x91,
0x51, 0x93, 0x53, 0x52, 0x92, 0x96, 0x56, 0x57, 0x97, 0x55, 0x95, 
0x94, 0x54, 0x9C, 0x5C,
0x5D, 0x9D, 0x5F, 0x9F, 0x9E, 0x5E, 0x5A, 0x9A, 0x9B, 0x5B, 0x99, 
0x59, 0x58, 0x98, 0x88,
0x48, 0x49, 0x89, 0x4B, 0x8B, 0x8A, 0x4A, 0x4E, 0x8E, 0x8F, 0x4F, 
0x8D, 0x4D, 0x4C, 0x8C,
0x44, 0x84, 0x85, 0x45, 0x87, 0x47, 0x46, 0x86, 0x82, 0x42, 0x43, 
0x83, 0x41, 0x81, 0x80,
0x40
} ;

unsigned short int CRC16(unsigned char *puchMsg, unsigned short int 
usDataLen)
{
   unsigned char uchCRCHi = 0xFF; /* high byte of CRC initialized */
   unsigned char uchCRCLo = 0xFF; /* low byte of CRC initialized */
   unsigned uIndex ;              /* will index into CRC lookup table 
*/
   while(usDataLen--)             /* pass through message buffer */
   {
      uIndex = uchCRCHi ^ *puchMsg++ ; /* calculate the CRC */
      uchCRCHi = uchCRCLo ^ auchCRCHi[uIndex] ;
      uchCRCLo = auchCRCLo[uIndex] ;
   }
   #ifdef INTEL_LIKE_PROCESSOR
     return (unsigned short int)((uchCRCLo << 8) | uchCRCHi);
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   #else
     return (unsigned short int)((uchCRCHi << 8) | uchCRCLo);
   #endif
}

See also
There are many ways of calculating a CRC checksum. For further information, please refer to the 
Modbus Organisation Website (http://www.modbus.org), where detailed descriptions and 
programming examples are available. 
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Modbus communication FCT010 C
C.1 Modbus addressing model

The device allows read/write access to the following standard Modbus RTU data holding register 
blocks:
• Holding registers (ref. 4x address range)
The minimum value of a writable holding register can be read by adding 10000 to the Modbus 
address of the register.
The maximum value of a writable holding register can be read by adding 20000 to the Modbus 
address of the register.
The default value of a writable holding register can be read by adding 30000 to the Modbus 
address of the register.

C.2 Modbus function codes
This device supports following function codes: 3, 8 and 16.
Function codes 3 and 16 are used for accessing registers, max. 16 registers per read/write 
request is accepted.
Function code 8 is used for reading Modbus communication diagnostic information.
Below the various function code are described.

Function code 3 (Read holding registers)
General exceptions:
• Requesting less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)

Holes/register alignment:
• The read command always returns data if no exception is given.
• Holes in the holding register map return value zero in all bytes. E.g. reading 2 registers 

starting at 4:0004 above will result in 2 bytes of "float B" followed by 2 zeroes.
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Function code 3 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
Byte count 1 byte
Register Value Hi 1 byte
Register Value Lo 1 byte
: :
Register Value Hi 1 byte
Register Value Lo 1 byte
CRC 2 bytes

Example: Read absolute massflow (address 3000)
Query: 1,3,11,184,0,2,70,10
Slave address  = 1 (0x01)
Function = 3 (0x03)
Starting Address Hi, Lo = 11, 184 (0x0B,0xB8)
Quantity of Registers Hi , Lo = 0, 2 (0x00,0x02) 
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0BB8 = 3000
Quantity of registers = 0x0002 = 2
Response: 1,3,4,64,195,82,139,98,200
Slave address  = 1 (0x01)
Function = 3 (0x03)
Byte Count  = 4 (0x04)
Register 1 - Register Value Hi, Lo = 64, 195 (0x40, 0xC3)
Register 2 - Register Value Hi, Lo = 82, 139 (0x52,  0x93)
CRC  = 98,200 (0x62, 0xC8)
Absolute mass flow = 0x40C35293 = 6.10383 kg/sec
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Function code 16 (Write multiple registers)
General exceptions
• Writing less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• If ByteCount is not exactly 2 times NoOfRegisters => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)
• Application errors include writing to ReadOnly holding registers

Holes/register alignment:
• If start-address is not the start of a mapped holding register => Exception 2 (Illegal data 

address)
• Writing to holes is allowed (ie ignored - and no exception occurs) - except for the condition 

described above
• If the end address is only part of a mapped holding register item (e.g. one half of a float 

value), the action depends on the data type. Writing parts of all data types => Exception 4 
(Slave device error)

Function code 16 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
Byte Count 1 byte
Registers Value Hi 1 byte
Registers Value Lo 1 byte
: :
Registers Value Hi 1 byte
Registers Value Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
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Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Example: Set baud rate to 115200 baud (address 529)
Query: 1,16,2,17,0,1,2,0,5,70,210
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)  
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01)
Byte Count  = 2 (0x02)
Registers Value Hi, Lo = 0, 5 (0x00,0x05)
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0211 = 529
Number of registers = 0x0001 = 1
Data 0x0005 = (115200 = value 5)
Response: 1,16,2,17,0,1,80,116
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01) 
CRC = 80,116 (0x50, 0x74)

Function code 8 (Diagnostics)
Modbus function code 8 provides a series of tests for checking the communication system 
between a client (Master) device and a server (Slave).
The following diagnostics functions are supported:

Sub-
func‐
tion 
code 
(Dec)

Name Description

00 Return Query Data The data passed in the request data field is to be returned 
(looped back) in the response.

10 Clear Counters and Diagnostic 
Register

Clears all counters and the diagnostic register. Counters are 
also cleared upon power–up.

11 Return Bus Message Count The response data field returns the quantity of messages that 
the remote device has detected on the communications sys‐
tem since its last restart, clear counters execution, or power–
up.

12 Return Bus Communication Er‐
ror Count

The response data field returns the quantity of CRC errors en‐
countered by the remote device since its last restart, clear 
counters execution, or power–up.
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Sub-
func‐
tion 
code 
(Dec)

Name Description

13 Return Bus Exception Error 
Count

The response data field returns the quantity of MODBUS ex‐
ception responses returned by the remote device since its last 
restart, clear counters execution, or power–up.

14 Return Slave Message Count The response data field returns the quantity of messages 
broadcast or addressed to the remote device that the remote 
device has processed since its last restart, clear counters exe‐
cution, or power–up.

15 Return Slave No Response 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device for which it has returned no 
response (neither a normal response nor an exception re‐
sponse), since its last restart, clear counters execution, or 
power–up.

16 Return Slave NAK Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Negative 
Acknowledge (NAK) exception response, since its last restart, 
clear counters execution, or power–up.

17 Return Slave Busy Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Slave 
Device Busy exception response, since its last restart, clear 
counters execution, or power–up.

18 Return Bus Character Overrun 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device that it could not handle due to a 
character overrun condition, since its last restart, clear coun‐
ters execution, or power–up.

20 Clear Overrun Counter and Flag Clears the overrun error counter and resets the error flag.

Function code 8 example
Query
Slave address 1 byte
Function 1 byte
Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
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Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes

Example: Read Return Slave Message Count (address 529)
Query: 1,8,0,14,0,0,129,200
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 0 (0x00,0x00)
CRC  = 129,200 (0x81, 0xC8)
Sub-function 0x000E = 14 = Read Return Slave Message Count
Response: 1,8,0,14,0,97,64,32
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 97 (0x00,0x65)
CRC  =  64,32 (0x41, 0xE3)
Read Return Slave Message Count = 0x0065 = 97 message received

C.3 Changing Modbus communication settings
Changing communication parameters, for example Baud Rate, Modbus Parity Framing or Bus 
Address effects the Modbus communication as follows:
• The new settings have effect only after a reset, either by restarting the device or writing the 

value 1 to Modbus address 600 Restart communication. 
• The new settings will not have effect until the Modbus driver has responded to any ongoing 

Modbus request.
NOTICE
Setting addresses in a multidrop network
It is recommended NOT to use the default address in a multi-drop network. When setting 
device addresses, make sure that each device has a unique address. Replication of addresses 
may cause abnormal behavior of the entire serial bus and make the master unable to 
communicate with all slaves on the bus.  
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C.4 Modbus holding registers tables
In the following the Modbus RTU holding registers available for the device are described.

Note
All Write parameters require password access.

Table C-1 Process values   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

3000 float / 4 Mass flow Measured mass flow - [kg/s] - Read Only
3002 float / 4 Volume flow Measured volume flow - [m3/s] - Read Only
3004 float / 4 Density Measured density - [kg/m3] - Read Only
3010 float / 4 Media temperature Measured temperature of 

the process media
- [°C] - Read Only

3023 float / 4 Frame Tempera‐
ture

Measured temperature of 
the sensor frame(1)

- [°C] - Read Only

(1) Only available if the sensor has frame temperature measurement
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Table C-2 Units for Process values and totalizer   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

7400 unsigned / 2 Mass flow unit Select unit for mass flow 
process value 

73: kilograms 
per second 
[Kg/s]
 

70: grams per 
second
71: grams per 
min
72: grams per 
hour
73: kilograms 
per second
74: kilograms 
per minute
75: kilograms 
per hour
76: kilograms 
per day
77: metric 
tons per mi‐
nute
78: metric 
tons per hour
79: metric 
tons per day
80: pounds 
per second
81: pounds 
per minute
82: pounds 
per hour
83: pounds 
per day
84: short tons 
per minute
85: short tons 
per hour
86: short tons 
per day
87: long ton 
per hour
88: long ton 
per day
253: custom‐
ized unit 

Read / 
Write

Modbus communication FCT010
C.4 Modbus holding registers tables

SITRANS MASS 2100 & FC300 (FCT010/DSL)
158 Operating Instructions, 06/2020, A5E39788682-AB



Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

7500 unsigned / 2 Volume flow unit Select unit for volume flow 
process value 

28: cubic me‐
ters per sec‐
ond
[m3/s]
 

15: cubic feet 
per minute
16: US gallons 
per minute
17: liters per 
minute
18: imperial 
gallons per mi‐
nute
19: cubic me‐
ters per hour
22: US gallons 
per second
23: million US 
gallons per 
day
24: liters per 
second
25: million lit‐
ers per day
26: cubic feet 
per second
27: cubic feet 
per day
28: cubic me‐
ters per sec‐
ond
29: cubic me‐
ters per day
30: imperial 
gallons per 
hour
31: imperial 
gallons per 
day
130: cubic 
feet per hour
131: cubic me‐
ters per mi‐
nute
132: barrels 
(= 42 US gal‐
lons) per sec‐
ond
133: barrels 
(= 42 US gal‐
lons) per mi‐
nute

Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

134: barrels 
(= 42 US gal‐
lons) per hour
135: barrels 
(= 42 US gal‐
lons) per day
136: US gal‐
lons per hour
137: imperial 
gallons per 
second
138: liters per 
hour
170: beer bar‐
rel per second
171: beer bar‐
rel per minute
172: beer bar‐
rel per hour
173: beer bar‐
rel per day
235: US gal‐
lons per day
253: custom 
volume flow 
unit 
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

7600 unsigned / 2 Density unit Select unit for density proc‐
ess value 

92: kilograms 
per cubic me‐
ter [kg/m3]
 

91: grams per 
cubic centime‐
ters
92: kilograms 
per cubic me‐
ter
94: pounds 
per cubic foot
95: grams per 
milliliter
96: kilograms 
per liter
97: grams per 
liter
98: pounds 
per cubic inch
93: pounds 
per gallon
99: short tons 
per cubic yard
146: micro‐
grams per liter
147: micro‐
grams per cu‐
bic meter
170: milli‐
grams per liter
253: custom 
mass flow unit 

Read / 
Write

7700 unsigned / 2 Temperature unit Select unit for temperature 
process value 

32: °C
 

32: °C
33: °F
34: °R
35: K

Read / 
Write

8320 unsigned / 2 Mass totalizer units Select unit for mass totalizer 
value 

61: kilograms 
[kg]
 

60: grams
61: kilograms
62: metric 
tons
63: pounds
64: short tons
65: long tons
125: ounces
253: custom‐
ized unit 

Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

8456 Float / 4 Custom unit factor 
mass flow value

Custom unit for mass flow 
value, only active if custom‐
ized unit is selected
 
Calculation is based on [kg/s] 

1 0 to 
60000000
 
 

Read / 
Write

7516 Float / 4 Custom unit factor 
volume flow value

Custom unit for volume flow 
value, only active if custom‐
ized unit is selected
 
Calculation is based on [m3/s]

1 0 to 1000
 
 

Read / 
Write

8462 Float / 4 Custom unit factor 
density value

Custom unit for density val‐
ue, only active if customized 
unit is selected
 
Calculation is based on 
[kg/m3]

1 0 to 60000
 
 

Read / 
Write

8474 Float / 4 Custom unit factor 
mass totalizer

Custom unit for mass totaliz‐
er, only active if customized 
unit is selected
 
Calculation is based on [kg]

1 0 to 1000000
 
 

Read / 
Write

Table C-3 Identification   
Modbus ad‐
dress

Data type / 
Size (bytes)

Parameter Description Default value 
(unit)

Value 
range

Access 
level

4000 String / 20 Manufacturer Device manufacturer Siemens - Read Only
4020 String / 10 Sensor Firmware Re‐

vision 
Sensor firmware version - - Read Only

4025 String / 16 SensorType Sensor type. 
Also shown on the device 
nameplate

- - Read Only

4033 String / 20 Sensor Serial Number Unique sensor serial num‐
ber. 
Also shown on the device 
nameplate

- - Read Only

4095 String / 10 Sensor Hardware Re‐
vision 

Sensor hardware version - - Read Only

4100 String / 10 Sensor Frontend Type Sensor hardware variant - - Read Only
4121 String / 20 Sensor Order Number Sensor order number part 1 

(MLFB). 
Also shown on the device 
nameplate

- - Read Only

4131 String / 32 Sensor Order Number Sensor order number part 2 
(MLFB). 
Also shown on the device 
nameplate

- - Read Only
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Modbus ad‐
dress

Data type / 
Size (bytes)

Parameter Description Default value 
(unit)

Value 
range

Access 
level

4147  String / 32 Sensor Order Number Sensor order number part 3 
(MLFB). 
Also shown on the device 
nameplate

- - Read Only

4164 String / 32 Long TAG Enter a unique TAG name for 
the device (up to 32 charac‐
ters)

   

4180 String / 16 Descriptor Enter a unique description 
for the measurement point 
(up to 16 characters)

   

4188 String / 16 Startup Date Enter the installation date of 
the device

   

Table C-4 Operating conditions     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2100 Unsigned / 2 Flow Direction Define positive and negative 
flow direction. 
Default positive flow direc‐
tion is indicated by the arrow 
on the sensor.
Possible selections:
• 0: Negative: The flow is 

measured '+' in default 
negative direction and '-' 
in default positive direc‐
tion.

• 1: Positive: The flow is 
measured '+' in default 
positive direction and '-' 
in default negative direc‐
tion

1 0 to 1 Read / 
Write

2130 Unsigned / 2 Process Noise Damp‐
ing

Select process noise damp‐
ing level:
0: 55 ms filtering (Centrifu‐
gal Pump)
1: 110 ms filtering (Triplex 
Pump) 
2: 220 ms filtering (Duplex 
Pump)
3: 400 ms filtering (Simplex 
Pump)
4: 800 ms filtering (Cam 
Pump)

2 0 Low to 4 
High

Read / 
Write
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Table C-5 Mass flow   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2125 Float / 4 Low Mass flow Cut-
Off 

Set mass flow limit for low 
flow cut-off.
Below this limit mass flow 
output is forced to zero.
If Low Flow Cut-Off is set to 0, 
the cut-off functionality is 
disabled.
Notice: 
It is recommended to set a 
lower value for gas applica‐
tions.

Sensor size 
specific [kg/
s] 1)

0 to 1023 Read / 
Write

2426 Float / 4 Mass flow Correction 
Factor

Specify correction factor for 
use in the mass flow calcula‐
tion

1 -1.999 to  
+1.999

Read / 
Write

1): See Sensor dimension dependent default settings (Page 140)

Table C-6 Volume flow   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2170 Float / 4 Low Volume flow Cut 
Off

Define the numerical volume 
flow value below which the 
volume flow output is forced 
to zero.

Sensor size 
specific [m3/
s] 1)

0 to 0.177 Read / 
Write

1): See Sensor dimension dependent default settings (Page 140)

Table C-7 Density   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2127 Float / 4 Empty Tube Limit Define threshold value of 
empty tube

500 [kg/m3] -14 000 to 
+14 000

Read / 
Write

2129 Unsigned / 2 Empty Tube Detection Set automatic detection of 
Empty Tube On/Off

0 = off (Empty tube is off).
1 = on (a density value below 
Empty Tube Limit triggers an 
alarm. All flow rate values 
are forced to zero %).

0 0 to 1
 

Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2442 Float / 4 Density Correction 
Factor 

Set density compensation 
value (gain) in order to make 
a density correction (scale 
factor).
To increase the displayed 
density value with +0.5 %, 
set the density factor to 
1.005.
The displayed density value 
will now be 0.5 % higher 
than before

1 -1.999 to  
+1.999

Read / 
Write

2444 Float / 4 Density Correction 
Offset

Set density compensation 
value (offset) in order to 
make an offset on the meas‐
ured density.
To make the flowmeter show 
+ 2 kg/m3, change the densi‐
ty offset to 2.000 kg/m3 in the 
'Sensor' menu

0 [kg/m3] -1 400 to +1 
400

Read / 
Write

Table C-8 Totalizer 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default 
value 
[unit]

Value range Access 
level

2609 unsigned / 2 Totalizer State Totalizer state 
• 0 = paused
• 1= running

1 0 to 1 Read only

2610 float / 4 Totalizer Value The totalized MASS value in 
kg

0 [kg] Min. -1.70E+38 
Max. 1.70E+38

Read Only

3018 Unsigned / 4 Totalizer fixed 
point part

The totalized MASS value in 
kg. Most significant word of 
the totalizer (MSW).
The format of the totalizer is 
a TotalType. 
The TotalType represent a 
fixed point value in the MSW 
32 bit and a fractional part in 
the LSW 32 bit.
Example: 2.03 would be rep‐
resented as fixed point part = 
2 and fractional part = 
30000000

0 [kg]
 

Min 
-2147483648
Max 
2247483647
 

Read Only
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default 
value 
[unit]

Value range Access 
level

3020 Unsigned / 4 Totalizer fractional 
part

The totalized MASS value in
kg. Least significant word of 
the totalizer (LSW).
The format of the totalizer is 
a TotalType.
The TotalType represent a 
fixed point value in the MSW 
32 bit and a fractional part in 
the LSW 32 bit.
Example: 2.03 would be rep‐
resented as fixed point part = 
2 and fractional part = 
30000000
Note: The data type is sign‐
ed32

0 [kg] Min -999999999
Max 999999999
 

Read Only

2612 unsigned / 2 Reset totalizer Reset totalizer Value - Enter 1 to reset Read / 
Write

2613 unsigned / 2 Pause totalizer Pause totalizer
Totalizer can only be paused 
when running 

- Enter 1 to pause Read / 
Write

2614 unsigned / 2 Resume totalizer Resume totalizer
Totalizer can only be re‐
sumed when paused

- Enter 1 to pause Read / 
Write

Table C-9 Access level 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

404 Unsigned / 2 Access level Access level status - 32 (logged 
in)
4 (logged 
out)

Read Only

412 Unsigned / 2 User password Password to enable writing 
commands

- 2457 (ena‐
ble user 
password
0 (disable 
user pass‐
word)

Read / 
Write
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Table C-10 Maintenance 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

700 Unsigned / 2 Set To Default Reset all parameters to facto‐
ry settings

- Enter 1 to 
reset

Write

2700 Unsigned / 4 Operating Time Total Total operating time since
first power up

0 [h] - Read Only

2702 Unsigned / 4 Operating Time Operating time since last
power up

0 [h] - Read Only

4088 String / 14 Firmware Time Stamp Firmware time stamp speci‐
fies the date and time when 
the sensor firmware was built

- - Read Only

4105 String / 32 Sensor PCBA Serial 
Number

Serial number of the sensor 
electronic

- - Read only

Table C-11 Device diagnostics
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2756 Float / 4 Driver Current Actual sensor driver current.
The actual driver current is 
viscosity and sensor size de‐
pendent

- [A] 0 to 0.124 Read Only

2758 Float / 4 Pick-up Amplitude 1 Actual pick-up 1 amplitude - [V] 0 to 0 9999 Read Only
2760 Float / 4 Pick-up Amplitude 2 Actual pick-up 2 amplitude - [V] 0 to 0 9999 Read Only
2762 Float / 4 Sensor Frequency Actual sensor frequency - [Hz] 0 to 1 023 Read Only
3032 Float / 4 PCB Temperature Actual sensor electronic tem‐

perature
- [C°] -50 to 200 Read Only

Table C-12 Aerated flow
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2200 Unsigned / 2 Aerated Flow Alarm 
Limit

Alarm limit calculated in per 
cent of accepted bad meas‐
urements.

80 [%] 0 to 99 Read / 
Write

2201 Unsigned / 2 Aerated Flow Warn‐
ing Limit

Warning limit calculated in 
per cent of accepted bad 
measurements

0 [%] 0 to 99 Read / 
Write

2202 Unsigned / 2 Measurement Sam‐
ple Time

The time period over which 
the actual percentage of bad 
measurements is calculated

5 [s] 1 to 10 Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2203 Unsigned / 2 Aerated Flow Filter Aerated flow filter
0: Disabled
1: Enabled
2: Auto
Auto means that filtering 
starts automatically when 
aerated flow is measured.

2 0 to 2 Read / 
Write

2204 Unsigned / 2 Filter Time Constant PV Filter Time Constant
0: 0.5 seconds
1: 1 second
2: 2 seconds
3: 5 seconds
4: 10 seconds
5: 20 seconds
6: 30 seconds
7: User Defined Value

4 0 to 7 Read / 
Write

2205 Float / 4 Filter Start Hysteresis The filter is active when the 
hysteresis value is exceeded.
Aerated Flow Filter must be 
set to Auto

0.015 [V] 0 to 0.124 Read / 
Write

2207 Unsigned / 2 Minimum Filtering 
Time

The filtering time is reset 
each time hysteresis band is 
exceeded

10 [ms cycles] 0 to 65535 Read / 
Write

2214 Unsigned / 2 Pickup Amplitude Fil‐
ter

Enable/disable pickup ampli‐
tude filter.
0 = Disable
1 = Enable

1 0 to 1 Read / 
Write

2215 Unsigned /
2

Bad Measurement 
Count

Number of bad measure‐
ments counted during the 
last period

0 0 - 65535 Read Only

2216 Unsigned /
2

Filter Iteration Set the number of times to 
repeat the same filter. In‐
creasing the number will in‐
crease the damping.
Active only if Filter Time Con‐
stant is set to 7.

3 1 to 5 Read /
Write

2217 Unsigned /
2

Bandwidth Factor Increase the Bandwidth Fac‐
tor to reduce the LP (low 
pass) bandwidth filtering.
Active only if Filter Time Con‐
stant is set to 7.

2 0 to 4 Read /
Write

2218 Unsigned /
2

Filter Pole Shift Configure the bandwidth 
and damping in the stop 
band. A high number will 
give a small bandwidth and 
an increased damping in the 
stop band.
Active only if Filter Time Con‐
stant is set to 7.

2 1 to 5 Read /
Write
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Table C-13 Zero point adjustment
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2132 Unsigned / 2 Zero Point Adjust‐
ment

Select zero-point adjustment 
method. Automatic zero 
point adjustment is recom‐
mended.
• 0 = Auto
• 1 = Manual

0 0 to 1 Read / 
Write

2133 Float / 4 Manual Zero Point 
Offset

Enter agreed zero point off‐
set value for manual zero 
point adjustment mode.

0 [kg/s] 0 to  1023
 

Read / 
Write

2135 Unsigned / 2 Zero Point Duration Define duration of zero point 
adjustment.

30 [s] 1 to 999 Read / 
Write

2136 Float / 4 Standard Deviation Standard deviation during 
auto zero point adjustment

0 [kg/s] -1023 to 
+1023

Read  only

2138 Float / 4 Standard Deviation 
Limit

Set limit for zero point adjust‐
ment Standard Deviation 
value. If the Standard Devi‐
ation exceeds the Standard 
Deviation Limit, the auto 
zero point adjustment is 
aborted.

Sensor size 
specific [kg/
s] 1)

0 to +1023 Read / 
Write

2140 Float / 4 Zero Point Offsett Lim‐
it

Set limit for zero point offset.
If the zero point offset ex‐
ceeds the zero point offset 
limit, the zero point offset 
cannot be stored

Sensor size 
specific [kg/
s] 1)

-1023 to 
+1023

Read / 
Write

2142 Float / 4 Zero Point Offset Val‐
ue

Default zero point offset 
based on factory calibration 
of sensor. 
A Zero point offset compen‐
sates for sensor variations 
due to process conditions.

0 [kg/s] -1023 to 
+1023

Read only

2144 Unsigned / 2 Zero Point Adjust Pro‐
gress

Shows the progress of the 
currently running Zero Point 
adjustment in percentage

0 [%] 0 to 100 Read Only
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2145 Unsigned / 2 Zero Point Adjust Sta‐
tus

Status of the last zero point 
adjustment performed
Every high bit ('1') represents 
an error occurred in the last 
zero point adjustment per‐
formed.

No high bits equals ok.
Bit 0  = Zero sigma limit ex‐
ceeded
Bit 1 = Zero offset limit excee‐
ded
Bit 2 = Quality of zero point 
conditions 

- • 1
• 2
• 4

Read Only

2180 Unsigned / 2 Start Zero Point Ad‐
justment

Start automatic zero point 
adjustment.
The automatic zero point ad‐
justment determines the ap‐
plication specific zero point 
offset automatically.
Possible selections:
• 0: Idle
• 1: Running
• 2: Start

0 0 to 2 Read / 
Write

1): See Sensor dimension dependent default settings (Page 140)

Table C-14 Modbus     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

527 Unsigned / 2 Float byte order The float byte order used in 
Modbus messages.

Selection 0: Byte order: 
1-0-3-2
Selection 1: Byte order: 
0-1-2-3
Selection 2: Byte order: 
2-3-0-1
Selection 3: Byte order: 
3-2-1-0

The first mentioned byte is 
the first byte sent.
Byte 3 corresponds to the 
left-most byte (MSB) of a 32 
bit float in big endian format, 
byte 0 corresponds to the 
right-most byte (LSB).

3 0 to 3 Read / 
Write

528 Unsigned / 2 Modbus Address Set Modbus Device Address 1 1 to 247 Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

529 Unsigned / 2 Baudrate Set communication bau‐
drate.
Following baud rates are 
available:
• 0 = 9600 
• 1 = 19200 (Default)
• 2 = 115200
• 4 = 38400
• 5 = 57600
• 6 =76800

1 0 to 5 Read / 
Write

530 Unsigned / 2 Modbus Parity Fram‐
ing

RS-485 parity and framing
8 databits are always used

0 = even parity, 1 stopbit
1 = odd parity, 1 stopbit
2 = no parity, 2 stopbits

0 0 to 2 Read / 
Write

600 Unsigned / 2 Restart communica‐
tion
 

Restart Modbus communica‐
tion
Write:
• 0 = No effect
• 1 = Restart
Read:
• Always 0

- 0 to 1 Write

Table C-15 Sensor 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2113 Float / 4 Minimum Frame Tem‐
perature

Lower limit of the frame tem‐
perature

-50 [°C]  Read only

2115 Float / 4 Maximum Frame 
Temperature

Lower limit of the frame tem‐
perature

200 [°C]  Read only

4043 String / 16 Sensor size Nominal sensor diameter 
(DN)

- - Read only

4051 String / 32 Hazardous area ap‐
proval

Hazardous area approval of 
the sensor

- - Read only

4078 String / 20 Wetted materials Sensor enclosure material - - Read Only
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Table C-16 Volume flow calibration
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2103 Float / 4 Maximum Volume 
flow Capacity

Maximum volume flow
measurement capacity of 
the sensor

Sensor size 
specific [m3/
s] 1)

0 to 0.177 Read only

1): See Sensor dimension dependent default settings (Page 140).

Table C-17 Mass flow calibration
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2101 Float / 4 Maximum Mass flow 
Capacity

Maximum mass flow
measurement capacity of 
the sensor

Sensor size 
specific [kg/
s] 1)

0 to 1023 Read only

2402 Float / 4 Calibration Factor Factory-set sensor-specific
calibration factor.
The calibration factor is
shown on the sensor name‐
plate

- Min: 5.00E
+07
Max: 4.29E
+09

Read only

1): See Sensor dimension dependent default settings (Page 140).

Table C-18 Density calibration
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2428 Float / 4 Density Calibration 
Offset

Specify an offset in the den‐
sity flow calculation

- -14 000 to 
+14 000

Read only

2430 Float / 4 Density Calibration 
Factor 

Specify gain factor in the 
density flow calculation

- -21474835
83 to 
214748358
3

Read only

2432 Float / 4 Dens. Comp. Tube 
Temp.

Specifies a tube temperature 
coefficient in the density cal‐
culation

- -0.001953 
to 
+0.001953

Read only

2434 Float / 4 Dens. Comp. Frame 
Temp.

Specifies a frame tempera‐
ture coefficient in the density 
calculation

- -0.001953 
to 
+0.001953

Read only
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Table C-19 Simulation     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2764 Float / 4 Mass flow Simulation 
Value

Set mass flow simulation val‐
ue.  
The mass flow will be set to 
this value on all outputs, 
if Simulation Mass Flow is 
enabled

0 [kg/s] -1023 to 
+1023

Read / 
Write

2766 Float / 4 Density Simulation 
Value

Set density simulation value. 
The density will be set to this 
value on all outputs, if Simu‐
lation Density is enabled

1000 [kg/m3] -20000 to 
+20000

Read / 
Write

2768 Float / 4 Media Temperature 
Simulation Value

Set media temperature simu‐
lation value. The media tem‐
perature will be set to this 
value on all outputs if Simu‐
lation media Temperature 
is enabled

0 [°C] -50 to +200 Read / 
Write

2770 Float / 4 Frame Temperature 
Simulation Value

Set frame temperature simu‐
lation value. 
The frame temperature will 
be set to this value on all out‐
puts if Simulation Frame 
Temperature is enabled

0 [°C] -50 to +200 Read / 
Write

2772 Float / 4 Volume flow Simula‐
tion Value

Set volume flow simulation 
value. 
The volume flow will be set 
to this value on all outputs, 
if Simulation Volume Flow 
is enabled

m3/s -65 to +65 Read / 
Write

2780 Unsigned / 2 Enable Simulation Activate simulation.
Select one of the following 
values:
• Bit 0: Mass flow
• Bit 1: Density
• Bit 2: Volume flow
• Bit 3: Media temperature
• Bit 4: Frame temperature

0  0 to 63 Read / 
Write
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Table C-20 Alarms     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

3012 Unsigned / 4 Alarm Group 1 The following bit is set in 
case of active alarm:
• Bit 4:

Power Supply Malfunc‐
tion

• Bit 6:
Temperature Circuit Mal‐
function

• Bit 10:  
Measurement Out Of 
Range

• Bit 14:
Calibration Malfunction

• Bit 15:
Compensation Out Of 
Range

• Bit 17:
Pickup Malfunction

• Bit 23:
Driver Malfunction

• Bit 26:
Measurement Out Of 
Range

• Bit 27:
Mass Flow Max Limit Ex‐
ceeded

• Bit 28:
Volume Flow Max Limit 
Exceeded

• Bit 29:
Density Max Limit Excee‐
ded

• Bit 30:
Min Tube Temp Exceeded

• Bit 31:
Max Tube Temp Exceeded

- - Read Only

Modbus communication FCT010
C.4 Modbus holding registers tables

SITRANS MASS 2100 & FC300 (FCT010/DSL)
174 Operating Instructions, 06/2020, A5E39788682-AB



Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

3014 Unsigned / 4 Alarm Group 2 The following bit is set in 
case of active alarm:
• Bit 0:

Min Frame Temp Excee‐
ded

• Bit 1:
Max Frame Temp Excee‐
ded

• Bit 2:
Zero Sigma Limit Excee‐
ded

• Bit 3:
Zero Offset Limit Excee‐
ded

• Bit 4:
Quality Of Zero Point 
Conditions

• Bit 5:
Empty Pipe

• Bit 6:
Sensor Partially Filled

• Bit 7:
Storage Malfunction

• Bit 8:
System Internal

• Bit 14:
Unstable Measurement 
Conditions

• Bit 15:
Auto-filtering enabled

• Bit 23:
Sensor Startup

- - Read Only
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Table C-21 Quality code for process values 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

3014 Unsigned / 4 Alarm Group 2 Quality code of a measured 
value

Process values 
for quality co‐
des
Media temper‐
ature
Density
Volume flow
Mass flow
Quality code 
for each proc‐
ess value con‐
sist of 2 bits:
Bit 24/25:
Media temper‐
ature
Bit 26/27:
Density
Bit 28/29:
Volume flow
Bit 30/31:
Mass flow

11 Good
01 Reserved
10 Simula‐
tion
00 Bad

Read Only

Modbus communication FCT010
C.4 Modbus holding registers tables

SITRANS MASS 2100 & FC300 (FCT010/DSL)
176 Operating Instructions, 06/2020, A5E39788682-AB



Index

A
Applications, 26

C
Cable requirements, 45
Cable specifications, 112
Catalog

catalog sheets, 137
Certificates, 13, 137
Certificates and approvals, 114
Characteristics

Density calibration, 172
Mass flow calibration, 172
Sensor, 171
Volume flow calibration, 172

Cleaning, 87
Commissioning

Steps, 51
Communication

Modbus, 170
Communication parameters

Setup, 54
Coriolis

Measurement principle, 139
Cross talk, 36, 104
Customer Support, (Refer to Technical support)

D
Design

Sensor, 19, 111
Designated use, 110
Device

identification, 21, 23, 24
Diagnosing

with SIMATIC PDM, 105
Diagnostics, 96
Dimensions

Remote versions, 132
Disassembly, 39
Disposal, 93
Document history, 7
Documentation

Edition, 7
Downloads, 137

E
Electrical connection

Cable requirements, 45
In hazardous area, 44

Empty tube monitoring, 79
Exception codes, 146

F
Flow direction, 32

H
Handling, 36
Hazardous area

Electrical connection, 44
Laws and directives, 13
Qualified personnel, 15

Hot swappable, 92
Hotline, (Refer to Support request)

I
Icons, (see Symbol)
Identification

Sensor, 162
Installation

Drop line, 35
Gas, 31, 33, 34
Incorrect, 104
Inlet / Outlet conditions, 31
Liquid, 31, 32, 34
Location in the system, 31
Mounting the sensor, 35
Orienting the sensor, 32
Upstream / Downstream, 31

Internet
Modbus Organisation, 18

L
Laws and directives

Disassembly, 13
Personel, 13

Low flow cut-off, 78, 103
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M
Maintenance, 85, 89

device status symbols, 95
Maintenance and Diagnostics

Access level, 166, 176
Aerated flow, 167
Device diagnostics, 167
Maintenance, 167
Zero point adjustment, 169

Manuals, 137
Mass flow cut-off limit, 79
Modbus

Features, 17
Frame, 18
Network, 53
Organisation Website, 18
Technical data, 117
Technology, 18

Modbus holding registers
Alarms, 174
Characteristics, 171
Communication, 170
Identification, 162
Maintenance & Diagnostics, 166, 176
Process values, 157
Setup, 163
Simulation, 173
Totalizer, 165

Modifications
correct usage, 13
improper, 13

Mounting, (See Installation)

N
Nameplate

FC300, 23
FCT010, 24
MASS 2100, 21
Specific information, 24

P
PDM

Commissioning steps, 51
Performance, 107
Power supply, 107, 112
Process noise damping, 80
Process values, 73, 157

Process variables, 114

Q
Qualified personnel, 15

R
Rated operating conditions, 113
Recalibration, 86
Reference conditions, 107
Repair, 89
Return procedure, 92

S
Scope of delivery, 10
Sensor design, 19
Sensor dimension dependent default settings

Fraction, 143
Mass flow, 140
Standard volume flow, 142
Volume flow, 141
Zero point adjustment, 145

Sensor orientation, (See Installation)
SensorFlash, 116
Service, 89, 138
Service and support

Internet, 138
Service information, 89
Setup

Density, 164
Mass flow, 164
Operating conditions, 163
Volume flow, 164

Signal processing, 140
SIMATIC PDM

Zero point adjustment, 63
Simulation, 83, 173
Specific information nameplate

FCT010, 24
Support, 138
Support request, 138
Symbol

configuration, 95
device status, 95
diagnostics, 95
maintenance, 95
operating mode, 95
process value, 95

Symbols, (Refer to warning symbols)
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System design, 110
System integration, 17

T
Technical data, 107, 110, 116
Technical support, 138

partner, 138
personal contact, 138

Termination DIP switches, 47
Test certificates, 13
Totalizer, 165

U
Unicast communication mode, 18
Units for Process values and totalizer, 158

V
Vibrations, 36, 104
Volume flow cut-off limit, 79

W
Warning symbols, 13
Warranty, 11

Z
Zero point adjustment, 77

Automatic, 77
Manual, 78
via SIMATIC PDM, 63
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